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1. Introduction

PowerPhotos is a utility that works alongside Apple Photos on your Mac to provide additional tools
to help manage your photo collection. One of its primary features is the ability to work with multiple
photo libraries, so instead of having to put your entire collection into Photos all at once, you can
divide your photo between multiple, smaller libraries. This can make it easier to browse your
libraries, as well as saving space on your internal drive and iCloud.

PowerPhotos also provides a wide array of tools for managing the libraries themselves, such as
album management, duplicate removal, metadata editing, search, and more

There are four main parts to the PowerPhotos window:

Library list:This is a list of the photo libraries that PowerPhotos knows about. The “+” button lets
you create a new, empty library, or add existing Photos libraries to PowerPhotos. You can rename
the items in the list by selecting the library, then clicking the name and typing in a new name. The
“-” button lets you remove a library from your library list (though the library will remain where it is on
your hard drive). You can also create library groups to further organize your libraries instead of
having them all in one long list. PowerPhotos reports can also be viewed here by toggling between
libraries and reports in the toolbar.

Album list:This displays the list of albums in the selected library. You can select an album to view
the photos it contains in the photo browser on the right, as well as drag albums to move them
around in the album list, or to another library to copy the album to that library.

Photo browser: The photo browser takes up the majority of the window, and allows you to browse
through the actual photos stored in whatever library you have selected. There is both a grid view,



which lets you browse photos much like in Photos, and a list view, which provides an easy way to
view your photos’ attributes, such as dates, ratings, keywords, etc. The View menu contains options
for sorting and viewing different photo attributes.

Inspector:The inspector pane on the right hand side of the window will show more detailed
information about whatever item you currently have selected in the window. This can display
information for a photo, album, or library, depending on what you have selected most recently. This
is also where you can edit the titles, keywords, and captions of selected photos.

1.1 Installation

PowerPhotos can be run from anywhere on your hard drive, but it’s recommended to store it in the
Applications folder, along with the rest of the applications on your Mac. In particular, if you use
PowerPhotos Shortcuts integration, its actions will only show up if it’s located in your Applications
folder.

Once you’ve downloaded the PowerPhotos.zip file to your Mac, Safari should automatically unzip it
in your Downloads folder. You can drag PowerPhotos from there into your Applications folder to
install it. To uninstall, drag PowerPhotos from your hard drive to the trash. If you are upgrading a
previous version of PowerPhotos, you can simply replace the old version with the new one, and your
list of libraries and all your settings will be retained automatically. You can also use the “Check For
Updates” menu item from within PowerPhotos to automatically check for, download, and install new
updates.

1.2 System Requirements

PowerPhotos 3.3 requires macOS 14.0 or later, and runs on both Intel and Apple Silicon Macs. If your
Mac is running an older version of macOS, older versions of PowerPhotos are available for download
from our website. PowerPhotos does not run on any other Apple platforms such as iPhone or iPad.

1.3 Licensing PowerPhotos

Many of the features of PowerPhotos work without a license key, but if you find PowerPhotos useful
and/or wish to use some of the advanced features only available to licensed users, a license can be
purchased for $39.95 by clicking the “Purchase PowerPhotos” button in the upper right corner of
the main window, or online at https://www.fatcatsoftware.com/store. The differences between a
licensed and an unlicensed copy of the program are outlined below

https://www.fatcatsoftware.com/powerphotos_downloads
https://www.fatcatsoftware.com/store


Unlicensed Licensed

Create new libraries Yes Yes

Use existing libraries Yes Yes

Library groups Up to 3 Unlimited

Search libraries Yes Yes

Find duplicate photos Find duplicates only Delete duplicates

Copy/move photos and albums 20 photos at a time Unlimited photo copying

Merge libraries Preview only Full merge

Delete photos 20 photos at a time Unlimited photo deletion

Batch edit metadata 20 photos at a time Unlimited editing

Export photos 20 photos at a time Unlimited exports

Convert iPhoto/Aperture libraries Yes Yes

Unlicensed copies of PowerPhotos can be used on as many computers as you’d like. A license for
PowerPhotos is for a single user, but allows for use on two machines (e.g. a desktop and a laptop). If
you intend have more than one user using the license-only features of the program, you should
purchase a license key for each person who will be using the program. If you buy a key for multiple
users, the number of users the license covers will be shown in the license window.

Upgrades

If you have a license key for PowerPhotos 1 or 2, or any version of iPhoto Library Manager, you can
enter your license key when purchasing PowerPhotos 3 to receive a 50% discount. If you’ve lost
track of your license key, you can have it emailed to you at our lost license page

Upgrading PowerPhotos to the latest version is not required - if you have a license for an older
version of PowerPhotos, you can continue running that version with your existing license without
needing to upgrade. If you need to download an older version of PowerPhotos you can find them at
the older downloads page.

Entering your license info

Once you’ve made your purchase, you’ll receive an email your license info, consisting of the name
you used to purchase, and a unique license key. If you already have the PowerPhotos app installed
on your Mac, the email will have a “Activate License” link which will automatically open up
PowerPhotos and enter your license info for you.

If that doesn’t work for any reason, you can also enter your license manually by opening
PowerPhotos and selecting “License…” from the PowerPhotos menu in the upper left, next to the

file:///lost_license/
file:///powerphotos_downloads


Apple menu. This will bring up the license window where you can enter the name and license key
from your email. Both the name and license key need to be exactly the same as in your order, so
make sure to copy and paste them from your email rather than try to type them in yourself.

Note: past versions of PowerPhotos have used the terms “registration code” or “serial number” but
was later changed “license key”. There is no functional change between the two, just a terminology
change.

Here is a summary of the major features differences between PowerPhotos 1, 2, and 3:



Features
PowerPhotos
1

PowerPhotos
2

PowerPhotos 3

Supported macOS versions 10.15 - 15.x 12.0 and later 14.0 and later

Create new libraries

Use existing libraries

Merge libraries

Search libraries
 (advanced

queries)

Find duplicate photos

Copy/move photos and albums Copy only Copy only Copy and move

iCloud optimized storage
support

Library groups

Delete photos

Export photos

Global menu bar item

Convert iPhoto/Aperture
libraries

Edit photo metadata

Batch edit metadata

Live updating photo browser

In-window photo viewer

Rename/move/delete albums

PowerPhotos Software License Agreement

1.4 Upgrading from PowerPhotos 1 or 2, or iPhoto
Library Manager to PowerPhotos 3.0

PowerPhotos 3.0 was released in 2025 and has a number of major new features and improvements

file:///powerphotos_license


over PowerPhotos 2.0. If you have an existing license for PowerPhotos 1.0 or 2.0, or any version of
iPhoto Library Manager, you can receive a 50% discount when upgrading to PowerPhotos 3.0 by
entering your old license key when placing your order at https://www.fatcatsoftware.com/store.

If you’re running PowerPhotos 3.0 on a Mac that already has a PowerPhotos 1 or 2 or iPLM license,
the “Upgrade PowerPhotos” button will automatically send your existing license key for you when
placing an in-app order.

If you need to retrieve your license info, visit our lost license page.

Here is a summary of the major additions to PowerPhotos 3.0.

Upgraded photo browser: The photo browser in PowerPhotos has gotten a major upgrade, and
can now do many of the same operations that you can do in Photos. This includes moving
photos between albums, deleting photos, and moving, renaming, and deleting albums. The
photo browser now also updates live when changes are made to the library, resulting in much
faster loading and browsing.

Keyboard centric metadata editing: A new inspector pane allows for quick editing of photo
titles, keywords, and captions, all without taking your hands off the keyboard. After entering
values, the tab key can be used to quickly navigate to the next photo without ever having to
touch the mouse/trackpad.

Batch metadata editing: Select a whole group of photos and edit their title, keywords, or
captions all at once. You can modify existing metadata with a templating system that lets you
include incrementing counters, dates, and other values in the newly entered metadata.

Advanced multi library search: A new indexing engine allows you to set up complex searches
using nested and/or predicates. You can either search one library or multiple libraries at once,
and searches can be saved for easy access later on.

New photo viewer: PowerPhotos now has its own in-window photo viewer instead of using the
system Quick Look window. This provides faster loading and navigating, while also still being
able to see detailed photo info in the inspector pane.

Move or copy photos between libraries: In addition to being able to copy photos/albums
between libraries, you can now move them instead. When moving photos, PowerPhotos will first
copy the albums/photos to the new library, and then delete them from the original library once
it’s done.

Multi library selection support: You can now select multiple libraries in the library list at a
time. This provides another way for initiating a merge, duplicate search, or lets you move or
delete more than one library at a time.

Improved undo support: PowerPhotos has added undo support in several additional areas,
including its various new editing features, as well as when configuring search predicates and
rearranging the library list.

Here is a summary of the major features differences between PowerPhotos 1, 2, and 3:

https://www.fatcatsoftware.com/store
https://www.fatcatsoftware.com/lost_license/


Features
PowerPhotos
1

PowerPhotos
2

PowerPhotos 3

Supported macOS versions 10.15 - 15.x 12.0 and later 14.0 and later

Create new libraries

Use existing libraries

Merge libraries

Search libraries
 (advanced

queries)

Find duplicate photos

Copy/move photos and albums Copy only Copy only Copy and move

iCloud optimized storage
support

Library groups

Delete photos

Export photos

Global menu bar item

Convert iPhoto/Aperture
libraries

Edit photo metadata

Batch edit metadata

Live updating photo browser

In-window photo viewer

Rename/move/delete albums

1.5 About Photos libraries

Photos stores all of the photos and information about your photo collection in a Photos library.
When viewing a Photos library in the Finder, it appears as a single icon, known as a package, but in
reality, that package contains a whole hierarchy of folders and files inside of it. When you import
photos into Photos, they are copied by Photos into the library package, and Photos takes care of
organizing them within that library and keeping track of where they are. Photos also creates a



handful of its own data files in the library along with the photos themselves. These files contain
information such as how you have your photos organized into albums, the title, favorites, keywords,
and other information you assign to your photos, and much more.

A Photos library is a self-contained unit, so all the photos and related data are all stored within that
one library package. This means that you can backup, move, or copy the library by simply copying
or moving the library package using the Finder, just like you would copy any other file or folder.

Typically, while working with Photos, it keeps all the details of the library package hidden from you.
You can just use Photos’ interface to manage your photos, and you never even need to look inside
the Photos library package itself. However, in some cases, especially if you encounter problems with
your Photos library, in can be useful to know a little bit more about what goes on inside the library. If
you wish to delve into the library package’s contents, you can do so by control-clicking on it in the
Finder and selecting “Show Package Contents” from the contextual menu. If you choose to do so
though, do not move, rename, or delete any items within the library package. Altering the library
contents in this manner can cause Photos to become very confused, and thus is not recommended.



2. Managing Photos libraries

2.1 The PowerPhotos library list

When managing libraries with PowerPhotos, the photo libraries you have on your computer don’t
automatically appear in PowerPhotos. Instead, you can choose which libraries you want to have
appear in the PowerPhotos library list in the sidebar on the left hand side of the PowerPhotos main
window. The pair of buttons above the library list in the toolbar can be used to switch between
viewing your libraries and viewing your reports in the sidebar.



Creating a new library To create a new library, either click the “+” button above the library list and
select “New Library”, or select “New Library” from the File menu. You will be prompted to choose a
name and location for the new library. When the library is first created, it will initially be empty, with
no photos. To open your newly created library, double click on it, and PowerPhotos will open the
library in Photos for you.

Adding libraries If you have a Photos library already on your disk, you can add it to your list by
clicking the “+” button and selecting “Add Library”, or by selecting “Add Library” from the File menu.
PowerPhotos will automatically search your computer using Spotlight for any libraries that are not
already in your library list. You can select one or more libraries from the list it displays and then click
“Add” to add those libraries to your library list.

Spotlight is not able to search some drives, such as network drives or other drives excluded from
Spotlight indexing. If a library you want to add does not appear in the search results, click the
“Choose Manually…” button, and that will let you select a specific library to add to the list.

Alternately, you can drag a library from the Finder and drop it into the library list in the PowerPhotos
window to add it to the list.

Removing libraries To remove a library from your list, select it then either click the “-” button or
select “Remove Library” from the File menu. Note that this will only remove the entry for the library
in the PowerPhotos library list and will not delete any of your files from the disk. If you really do want
to move the library to the trash, you can hold down the option and shift keys, and the “Remove
Library” command will change to “Delete Library” instead. This will both remove the library from the
library list and move the library to the trash for you. Note that you’ll still need to empty the trash via
the Finder or Dock in order to delete the library permanently.

By default, PowerPhotos will warn you when you are about to remove a library from your list. If
desired, you can turn this warning off in the settings.



2.2 Duplicating a library

If you want to make an exact copy of one of your libraries, either as a backup or as part of moving a
library to another disk, you can do so one of two ways.

Choose the library you want to copy and choose the “Duplicate Library” command from the File
menu. You will be prompted to choose a location to store the new copy of the library.
PowerPhotos will copy the library and, when it’s done, it will automatically appear in your library
list.

Choose the library you want to copy and choose “Reveal Library in Finder” from the File menu.
You can then use the Finder to copy the library to the location you want the copy to be. After it
is done, if you want to work with that library in PowerPhotos, add it to your library list.

Referenced Photos If you have unchecked the “Copy items to the Photos library” checkbox in the
Photos settings window, then when you import photos into your library, those photos don’t get
copied into the library package, but are instead referenced in whatever folder they were originally
stored in.

Any such referenced photos will not be copied when duplicating the library. The duplicate copy of
the library will simply reference the same photos in the same external locations. If you’re duplicating
the library with the intention of transferring it to another machine, the duplicate library will not be
able to find any of the external photos if they are not available from that machine.

If you’re not sure whether your library has any referenced photos, you can find out by doing the
following:

1. Open your library in Photos.

2. Select File > New Smart Album.

3. Set up the album’s conditions with one that reads “Photo is referenced”

4. Give the album a name like “Referenced Photos”, then click “OK” to finish creating the album.

If the album is empty, that means your library does not have any referenced photos, and can be
duplicates without any problem. If you do have references photos and want to bring them all into the
library so they’re no longer references, select all the photos in that smart album, then use the File >
Consolidate menu item in Photos to copy your referenced photos into the library package. When you
then duplicate the library, all the photos will be included in the duplicate copy.

iCloud Photos If you have a library that has iCloud Photos enabled, then it is possible that the
library will not have downloaded all the full size versions of each photo from iCloud at the time you
duplicate the library. This is almost always true when the “Optimize Mac Storage” option is enabled
in Photos’ preference, but can also be the case for a small number of photos even if “Download
Originals” is checked instead.

If you duplicate such a library, then the new copy of the library will appear to have all of its photos
intact, but some (or many) of the photos will be incomplete or missing, not having had their full size
versions downloaded from iCloud. Trying to view or edit such photos may result in error messages
being displayed by Photos. So, when copying a library that’s syncing with iCloud, it’s highly
recommended to switch to the “Download Originals” option in Photos’ settings window.

https://support.apple.com/guide/photos/change-where-photos-and-videos-are-stored-pht1ed9b966d/mac


Duplicate a library on an APFS volume Apple introduced a new volume format called APFS (Apple
File System) starting in macOS High Sierra. APFS supports a feature called “cloning” that can save
space when making copies of large files and folders. Instead of making a separate copy of all the
library data up front when duplicating a library, a “clone” is made that references the same data as
the original library. As further changes are made to one copy of the library or the other, APFS will
automatically copy individual files as they are modified, making sure that the changes you make to
one library don’t apply to both libraries.

The end result of this is that:

1. Duplicating a library on APFS will typically only take a few seconds, no matter the size of the
library.

2. The available free space on your drive will not change after duplicating the library, even though
both libraries will show in the Finder as taking up the same amount of space.

3. Modifying one copy of the library won’t affect the other, just like a normal copy would behave on
a non-APFS volume.

4. As you modify one library or the other, you’ll slowly see additional space consumed as files are
copied on demand before being modified.

2.3 Moving a library

If you wish to move one of your libraries to a new location on a single drive, PowerPhotos will
automatically track the library when you do so. Select the library you want to move in PowerPhotos
and select “Reveal Library in Finder” from the File menu to show the library in the Finder. Then, use
the Finder and move the library to the new location on the drive. You will see PowerPhotos update
the path for that library as soon as you bring its main window back to the front.

If you wish to move your library from one drive to another, you will need to copy the folder to the
new drive and then add the copied library to PowerPhotos’ list. After you have opened up the newly
copied library with Photos and confirmed that it displays correctly, you can go ahead and delete the
original copy of the library. Another way to do this is to use PowerPhotos’ “Duplicate Library”
command in the File menu to make a copy of the selected library on another drive.

2.4 Renaming a library

You can assign any name you wish to each of your libraries in the list by first selecting the library,
and then clicking on its name to begin editing it (just like renaming a file in the Finder). Alternately,
you can control-click on the library and select “Rename Library” from the contextual menu that pops
up.

When you first add a library to PowerPhotos, it will be given the same name as the library package
has in the Finder. The Finder name and the name in PowerPhotos are separate though, so you can
change one without having to change the other. For example, if you’ve added a library that belongs

https://en.wikipedia.org/wiki/Apple_File_System


to another user, and that library is named simply “Photos Library”, you can give it a different name in
PowerPhotos such as “Bob’s Library” without affecting the name of the actual library on disk.

When renaming a library in PowerPhotos, only the name in the PowerPhotos library list will be
changed, and the library will keep its same name on disk. You can also change the name of the
library on disk separately via the Finder. When you bring PowerPhotos to the front, it should see the
change and update the path for the library to point at the new location. PowerPhotos will not
automatically change its own display name for the library in this case.

If a library shows up in red in the list, it means that the package for that library does not exist on the
disk (e.g. it was moved or deleted), or the disk the library resides on is not currently available. If the
library is kept on another disk, insert or connect the disk, and the library name should change back
to black, indicating the library is now available. If it’s a library that you intentionally deleted or no
longer need to access, you can use the “Remove Library” command to remove the library from the
list.

2.5 Using library groups

If you have a large number of Photos libraries, PowerPhotos allows you to organize your libraries into
groups in the library list.

Creating groups To create a new library group, select File > New Library Group, and the new group
will appear in the library list, allowing you to type a name for it. Each group has an indicator showing
how many libraries are in that group, and a button containing a menu with several actions that can
be taken on the group.

Arranging libraries and groups To add your existing libraries to a group, drag the library from
where it is in the list and drop it into the group. You can also drag libraries directly from the Finder to
add them to groups. Libraries can be reordered within a group by drag and drop, and groups
themselves can be reordered as well. Once you have libraries organized into groups, you can click
the triangle next to a group’s name to collapse it, making it easier to browse your groups without
having to scroll through the long list of libraries.

Renaming a group To rename a group, click the “…” button and select “Rename Group” from the
menu that appears.

Deleting a group You can delete a group by clicking the “…” button in the group’s row and choosing
“Delete Group” from the menu that appears. When deleting a group, you’ll be given a choice for
what to do with the libraries that are currently in that group. You can either remove all the group’s
libraries from the library list as well, or you can move the libraries to a different group. The default
“Photo Libraries” group at the top of the list is always there and cannot be deleted.

2.6 Selecting multiple libraries

PowerPhotos supports selecting multiple libraries at once from the library list, to allow you to easily



perform certain operations on a whole batch of libraries at once, rather than having to perform the
same action over and over again on individual libraries. To make a multiple selection in the library
list, you can hold down either the command key or the shift key, and click on another library in the
list to add to your current selection. Using the command key will just add the one library you click on
to your selection, whereas the shift key will select all the libraries between the one you currently
have selected and the library you just clicked. You can also command-click on an already selected
library to remove it from the selection.

Once you have multiple libraries selected, you can drag them all at once if you want to rearrange
your library list, e.g. adding a whole bunch of libraries to a library group at once.

You’ll also see a group of buttons in the middle of the window that let you do the following:

Search libraries This will let you perform a search of all the selected libraries. Visit the chapter on
searching for more details.

Find Duplicates This will set up a duplicate search to let you find duplicates among the selected
libraries.

Merge Libraries This starts the setup for a merge that lets you combine the contents of all the
selected libraries into one library.

Remove Libraries This lets you remove all the selected libraries from the library list at once.

2.7 Accessing a Photos library on another Mac

To share your Photos library across a network, you first need to decide where the library itself will be
stored. Choose which computer will hold the library, then open System Settings on that computer
and enable Personal File Sharing in the Sharing pane. Details on enabling file sharing on macOS can
be found on Apple’s support site at these links:

How to connect with File Sharing on your Mac

Once that’s done, go to another computer that you’d like to access the library from and go the
Finder. To connect to the shared computer, follow the directions on Apple’s support site at:

Connect your Mac to shared computers and servers

When you connect to the remote machine, it’s easiest to log in with your default admin username
and password, since that will let you access any hard drive on the machine, and thus let you store
your photos anywhere you want on the machine. Once you’re connected, you can open up
PowerPhotos and set up your machine to use the remote library. Note that Photos requires both read
and write access to a library in order to open it, even if you don’t intend to actually make any
changes, so make sure you log in as a user that is able to modify the library.

If you have a Photos library set up on the remote machine that you want to use on your machine, all
you have to do is add the library from the network drive to PowerPhotos just like you would any
other library, either by selecting File > Add Library or by dragging the library into the library list.
Once the library shows up in PowerPhotos, you can access it just like any other library.

When accessing this library, the machine where the library is stored must be awake and available on
the network, and the other machine must be connected to that machine via file sharing, otherwise

https://support.apple.com/kb/HT204445
https://support.apple.com/guide/mac-help/connect-mac-shared-computers-servers-mchlp1140/mac


Photos may display an error when you try to open the library. PowerPhotos will automatically
attempt to connect to the remote machine when you try to open the library. The machine still must
already be awake for this to work, and you’ll need to type in the appropriate username/password to
connect to the machine, but this can save you from having to remember to connect to the machine
manually before opening the library.

In order to access the same library from multiple Macs, both Macs must have exactly the same
version of macOS (and Photos) installed. If you open a library from a Mac with an older version of
macOS, Photos will ask to upgrade the library to the newer version, after which the older version of
macOS will no longer be able to read it.

Note: whichever library is designated the “System library” on the Mac where the library is stored will
effectively always be open by macOS in the background. Since there is no way to fully close the
library in this case, your system library cannot be opened from another Mac. If you wish to access a
library from more than one Mac, you must designate another library to be your system library
instead. This also means there is no way to create a setup where a library is both synced with iCloud
and accessible locally from multiple Macs.

2.8 Backing up your Photos libraries

Your photos are some of your most valuable data on your Mac, containing special memories that you
want to make sure to preserve. Making regular backups is a critical step in managing your Photos
libraries, and there are several methods you can use to make those backups, depending on your
particular setup.

Time Machine

Time Machine is a feature that comes built-in to macOS and is a very good and simple way to keep
your photos backed up. Once you have an external drive set up with Time Machine, all your Photos
libraries will automatically be backed up for you in the background. Time Machine can be used with
a USB/Thunderbolt external drive attached to your Mac, as long as the drive is formatted as MacOS
Extended or APFS, or with some NAS systems that are compatible with Time Machine (consult your
NAS’ documentation for details on setting that up).

Manual copying

If you only occasionally have a backup drive connected to your Mac, or don’t want everything on
your machine backed up like Time Machine does, you can back up your libraries manually by simply
copying each one to an external drive. Each library is a self contained unit (with the notable
exception of referenced photos), so you can just copy the library package to your external drive
either using the Finder or the File > Duplicate Library command in PowerPhotos. If you’re copying
your iCloud library with the “Optimize Mac Storage”, please read the limitations of backing up your
library in the last section of this page.

Cloud storage services

Some cloud storage services (e.g. Dropbox, Google Drive) can be used to store a backup copy of
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your library, but only as a one way backup and not to sync between multiple Macs. (read more
here about why you can’t sync libraries with cloud services). If you store your library (or periodically
make a copy of your library) in the folder that syncs with your cloud service, then that will upload a
copy of those files to the cloud so that they can be restored if your Mac should be lost, stolen, or
otherwise meet an untimely demise.

Note however that iCloud Drive will ignore any photo library that you place in the iCloud Drive folder
and will not upload it at all. The only way to put your photo library in iCloud is to use iCloud Photos.

Cloud backup services

These are cloud services that are designed to do a one way back up of your data to the cloud,
services such as Backblaze, CrashPlan, and a number of others. These differ from cloud storage
services like Dropbox or Google Drive which are aimed at syncing files between multiple computers.

Most cloud backup services will do a good job of backing up your photo libraries to their cloud
storage. If you store any of your libraries on an external or network drive, the one thing you’ll want to
check is if your service supports backing up content that you store on external drives, or if it will
only back up what’s on your internal drive.

iCloud Photos and backing up

iCloud Photos is a very useful service that lets you easily have a copy of your photos in the cloud
and access your photos from multiple devices. However, you should not rely on iCloud Photos to be
your primary backup solution for your photos. The main reason for this is because any changes you
make to your photo library automatically get synced to iCloud, and to the rest of your devices. This
includes things like deleting photos and albums, which means if you accidentally delete something
you want to get back, you won’t be able to get it from iCloud Photos. You need to have another
backup strategy in addition to iCloud Photos.

Backing up and the “Optimize Storage” iCloud Photos option

If you use iCloud Photos with the “Optimize Storage” option enabled, then Photos will only download
the full size versions of your photos on demand, e.g. when you go to view or edit individual photos in
full size. This means that if you directly back up your Photos library, you will only be backing up
whichever photos that Photos has happened to download to your local hard drive.

If you don’t have room on your internal drive to store everything that’s stored in iCloud Photos, then
you’ll need to set up a separate library on an external drive that syncs to iCloud using the “Download
Originals” option, then also back up that library to ensure you have backups of all your photos. Here
are two way you can do that.

If you have a setup where you can keep your external drive connected to your Mac most of the time,
then you can do the following:

1. Create a new user account on your Mac and sign into your same Apple ID on that account.

2. Enable fast user switching

3. Login to that account and open PowerPhotos.

4. Use PowerPhotos to create a new photo library on your external drive, then open that library in
Photos.

https://support.apple.com/guide/photos/from-icloud-photos-phtf5e48489c/8.0/mac/13.0
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5. Open the Photos settings window and click the “Use as system photo library” button. Then go
to the iCloud section, enable iCloud Photos, and select the “Download Originals” option. Photos
will start to download everything from iCloud into the library on the external drive.

6. Don’t log out of the account, but rather use fast user switching to switch back to your regular
user account.

7. You can pretty much just leave the setup like that, and as long as the second account remains
logged in in the background, it will continue to download data from iCloud. If you restart your
Mac at any point though, you’ll need to remember to log back into that second account so it can
keep syncing with iCloud Photos.

If you can only plug in your external drive periodically, you can still use the procedure above, or you
do something similar as follows:

1. Instead of creating a new user account, just create a new library on the external drive, then
open the library in Photos.

2. The same as above, switch that library to be the system library, then enable iCloud Photos with
the “Download Originals” option. This will temporarily disable iCloud syncing with your default
library.

3. Allow Photos to download all the content from iCloud Photos. You can check on progress by
going to the “All Photos” view in Photos and scrolling all the way to the bottom of the photo
browser.

4. Once it’s done downloading everything, reverse the procedure. Use PowerPhotos to open your
original library up in Photos, make it the system library, and reenable iCloud Photos there, but
with the “Optimize Storage” option selected.

5. For further backups, repeat steps 2-4 above whenever you have a chance to plug in your
external drive for a little while.

2.9 Library versions and upgrading

The Apple Photos app ships as part of macOS, with each version of macOS having a corresponding
version of Photos included with it. Each of your Photos libraries also has a version number
associated with it, matching whatever the last version of Photos was that opened that particular
library. You can see a library’s version by selecting it in PowerPhotos and looking in the inspector
pane on the right. One result of this versioning is that both Photos and PowerPhotos are only able
to open a library that exactly matches the installed version of Photos.

Older libraries

If you have a library from an older version of Photos/macOS, the first time you open that library in
Photos, it will automatically be upgraded to the latest version, with Photos showing a progress bar
as it works, since the upgrade process can sometimes take a little while to complete.

When selecting an older library in PowerPhotos, it will display a message saying the library needs to
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be upgraded in order to be used, along with an “Upgrade Library” button that you can click. To
upgrade the library, PowerPhotos will simply open that library in the Photos app and let it apply its
normal upgrade process. Once the upgrade is complete, when you return to PowerPhoto it will then
be able to display the library contents.

Newer libraries

Occasionally, you will encounter a library from a newer version of Photos/macOS than the one you’re
running. The most common scenario is when you copy a library from another Mac (e.g. over the
network or via an external drive) and that other Mac is running a newer version of macOS than the
Mac you’re trying to view the library with. Unfortunately, there is no way to “downgrade” a library to
an older version. The only options for viewing that library will either be to upgrade macOS on that
Mac to at least the version of the other, newer Mac, or restore the library from a backup that was
made before the other Mac had its macOS upgraded.

Upgrading multiple libraries

If you maintain a large number of Photos libraries, each time you update your version of macOS, this
requires also updating each one of your libraries before you can use it in PowerPhotos or Photos.
Normally you would have to manually open each library in Photos to have it upgraded, but
PowerPhotos will help automate upgrading multiple libraries at once.

To upgrade multiple libraries, start by making a multiple selection in the library list, i.e. by holding
down the command key or shift key while clicking to select multiple items. If one or more of the
libraries you selected needs an upgrade, a message will be displayed near the bottom of the window
saying how many of the selected libraries need to be upgraded. Clicking the arrow next to the
message will give you more detail about exactly which libraries need an upgrade. You can click the
“Upgrade Libraries” button if you want to proceed with upgrading.



Here you will be given a setup screen where you can customize which libraries you want to upgrade.
If there are some you don’t want to upgrade, click the X next to the library to remove it from the list.
If there are additional libraries you want to upgrade, drag them into the box in the setup view. Once
you have decided which libraries to upgrade, click the “Upgrade Libraries” button in the upper right
to begin the upgrade process.

PowerPhotos will open each library in turn in the Photos app, wait for Photos to complete the
upgrade, then quit Photos again and proceed to the next library. This means you will see the Photos
window appear and disappear multiple times during the upgrade process, once for each library.
Once PowerPhotos has finished, your libraries should now all be ready to use in Photos and
PowerPhotos.



3. Using your Photos libraries

3.1 Opening a library

PowerPhotos lets you manage multiple Photos libraries, but only one of your libraries can be open in
Photos at any given time. In your list of libraries, whichever library has a green checkmark appearing
next to it is the active Photos library. Opening Photos, either by using the “Open Photos” button in
PowerPhotos, or by clicking on Photos in the Finder or on the dock, will display the active library in
Photos.

To switch to another library, just double click the library’s icon in PowerPhotos, and it will take care
of quitting Photos, changing the active library, and then reopening Photos to display the library that
you double clicked. PowerPhotos keeps a separate copy of your Photos settings for each of your
libraries, and will swap the settings whenever it switches to a different library. This allows you to
have different settings in the Photos settings window on a per-library basis.

An alternate method is to double click the library itself in the Finder to open that library up in
Photos. This works, but using this method will not swap out the Photos settings like PowerPhotos
does when switching libraries.

3.2 About the System Photo Library

If you have multiple Photos libraries, at any given time there will be only one that is designated as
the System Photo Library. This library is the one that is made available by macOS for other
applications to access directly. This library will appear in the photo browser in apps like Mail, iMovie,
and Pages, as well as other services like your screen saver settings. Applications that offer to import
into Photos will import into the system library. The system library is also the only library that can be
synced with iCloud.

If you wish to use photos from other, non-system libraries with your apps (e.g. attaching a photo in
Mail), you will need to open the library containing the photo you want in either Photos or
PowerPhotos. You can then drag the photo from the Photos/PowerPhotos window and drop it into
the other app (e.g. into a Mail message window to add an attachment) rather than using the app’s
own photo browser. One easy way to access your other libraries quickly is to enable the “Show
PowerPhotos in menu bar” open in the PowerPhotos settings window.

To specify which library you want to be the system photo library, open the library in Photos, open
the settings window, and click the “Use as System Photo Library” button. (if the button is disabled,
that means the library is already the system photo library) Simply opening a library in Photos will not
switch the system photo library, so you can feel free to open and work with other libraries without
changing which library is set as the system photo library.

For more information on the system photo library, visit this support article on Apple’s website.

https://support.apple.com/kb/HT204414


3.3 Using iCloud Photos with PowerPhotos

Apple offers a service called iCloud Photos that allows you to easily sync the photos you have on
your Mac with those you take on your iPhone, iPad, or even another Mac. Using iCloud Photos is
optional, and is off by default - you can store your photos on your Mac without doing any syncing to
iCloud if you wish.

Only one library can be synced with iCloud at any given time. You must first designate that library as
the system photo library in Photos’ settings, at which point you can enable iCloud Photos, also in
Photos’ settings. When viewing your libraries in PowerPhotos, an “iCloud Library” label will appear
below the library’s name.

There are currently not any options provided by Photos to sync a subset of your library with iCloud -
it’s all or nothing. PowerPhotos can help with this limitation by allowing you to create separate
libraries to store the photos that you don’t want to have synced with iCloud. For example, if you just
want a relatively small selection of photos to sync with iCloud, you can set up a library just for that,
then store the bulk of your photos in other libraries that are not synced. This helps save storage
space used on your iCloud account.

Optimize Mac Storage Photos also provides an option to “Optimize Mac Storage” when using
iCloud Photos. When enabled, if your disk starts to run low on free space, Photos will not store the
full size original versions of photos on your Mac. It instead leaves the full size copies on iCloud, and
only downloads the ones it needs on demand (e.g. when you view or edit a particular photo).

When you have this option enabled, viewing or copying photos or videos with PowerPhotos may
mean that Photos needs to download data for some or all of the items being copied. This may cause
some operations to take longer to complete, and make your library take up more local disk space.

In addition to iCloud Photos, Photos offers two other way to transfer photos between devices: My
Photo Stream and Shared Albums. These two features can be enabled or disabled independently of
iCloud Photos, but like iCloud Photos, they can only be enabled for your system photo library.
Photos from these sharing options will not appear in PowerPhotos.

3.4 Using iCloud Shared Photo Library with
PowerPhotos

Starting in macOS 10.13 Ventura and iOS 16, Apple now offers the ability to have a Shared Library
that allows multiple people to contribute to a single shared library that is synced via iCloud Photos
to all of their devices. If you have the Shared Library feature enabled in Photos’ settings, all of your
photos will either be in your personal library (accessible to only you) or your shared library
(accessible to other users who share the same library).

In Photos, you will see a menu at the top of the window that lets you switch between viewing just
your personal library, just your shared library, or the contents of both libraries combined together. In
PowerPhotos (and any other third party app), you will always see the combined contents of both



libraries when browsing through your photos. Apple doesn’t provide a way for PowerPhotos to tell
which photos are from the personal library and which are from the shared library, so you will need to
view your library in Photos to see that information.

Whenever you use PowerPhotos to import, copy, or merge photos into your system library when you
have the shared library enabled, those photos will always be imported into your personal library, and
not the shared library. After photos have been added to the personal library, if you want to move
them to the shared library, you can open up Photos, select and control-click the photos you want to
move, and select the “Move to Shared Library” menu item.

Note that all of this only applies to your system library, and only if you have both iCloud Photos and
Shared Library enabled in the Photos settings window. Any other libraries you have set up in
PowerPhotos act as libraries that are local to your Mac and don’t interact with iCloud at all.

Known Photos bug when duplicating a library There is a bug that you may encounter if you make
a duplicate copy of your system library while Shared Library is enabled, either using the Finder or
the Duplicate Library command in PowerPhotos.

If you open up the new copy of the library in Photos, it will still show the controls for switching
between your shared and personal library up at the top of the Photos window. However, despite the
presence of these controls, the copy of the library is not connected to iCloud Photos or your Shared
Library at all. You can even use the menu commands in Photos to move photos between the
personal and shared sections of the library, but those changes will not sync to iCloud and will not
appear in the actual shared library for any users.

3.5 Using a digital camera with multiple libraries

One of the primary uses of Photos is to import and organize photos you have taken with your digital
camera. There are a couple things you should know about how this works when you have multiple
Photos libraries.

If you have Photos set up to launch automatically as soon as your plug your camera in, this will
cause Photos to open whichever library you had last chosen to work with in Photos. This can
sometimes cause the wrong library to be opened up, at which point you have to quit Photos, go
open up PowerPhotos, switch to the correct library, and then open up Photos again. If this happens
to you a lot, you might want to instead set PowerPhotos to open up when you attach your camera
rather than Photos. This way, you can be sure that you have the right library selected before opening
up Photos, and avoid importing photos into the wrong library.

To set this up, open up the Image Capture application located in your main Applications folder on
your hard drive. Plug in your camera, and it should appear in the “Devices” section. Select the
device, then use the pop-up menu at the bottom of the list and select “Other…”, at which point you
can select PowerPhotos in your Applications folder, and click OK. Now, when you plug in your digital
camera, PowerPhotos should automatically open instead of Photos. Note: on some systems, even
after selecting PowerPhotos to open, the pop-up menu may still read “No Application”, but
PowerPhotos will still launch when plugging in the camera.



3.6 Storing libraries on cloud services such as
Dropbox or iCloud Drive

It is common for Mac users to want to store their photo libraries in a folder managed by a cloud
syncing services, such as Dropbox, Box, or Google Drive (just to name a few). Theoretically, having
your library stored here would allow you to access your whole photo collection from multiple Macs
and keep them easily synced. Unfortunately, the Photos library format is not designed with this in
mind, and storing your library in one of these services can result in corruption of your library. This is
not due to any fault of the cloud services provider: the library format simply doesn’t mesh well with
the per-file syncing engine used by these services. It is highly recommended that you do not
store your library in one of the folders managed by a cloud syncing service.

iCloud Drive

Apple’s own iCloud Drive feature (not to be confused with the iCloud Photos feature of the Photos
app) has similar issues to the ones experienced with third party cloud syncing services. Photos will
allow you to create a library in iCloud Drive, but you will see a small￼

icon next to the library in the Finder, indicating that the item is “ineligible” for iCloud Drive syncing.
Your library will remain there and function fine, but its contents will not sync to iCloud at all, and you
will not see it appear on other Macs you use with iCloud Drive.

Simply put, if you wish to sync your photo collection across multiple Macs, iCloud Photos is the best
solution available.

3.7 Storing a library on an external drive

You can store an Photos library on an external or removable hard drive just the same as you can on
your computer’s built-in hard drive. To create a new library, follow the normal procedure for creating
a new library, and choose the external drive as the location for the library. If you have an existing
library that you would like to store on your external drive, use the “Duplicate Library” command in
the File menu. You will be given a choice of where to duplicate the library to, at which point you can
choose the external hard drive that you’d like to copy the library to. Once you’ve created or copied
your library on the external drive, you can then open it up just like any other Photos library.

Apple recommends that you store your Photos library on a Mac formatted drive (either MacOS
Extended or APFS), and recommends against using SD cards and USB flash drives, as well as
network drives. Unless you have a particular need for your external drive to be accessible from a
Windows or Linux machine, make sure the disk is formatted as MacOS Extended or APFS, which you
can check using the “Get Info” window in the Finder.

For network drives, on macOS Catalina and later a Photos library can be stored on a NAS as long as
you’re connecting via the SMB 2/3 protocol, and not Apple’s older AFP protocol which is now
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deprecated. Photos is not optimized for working over a network, so working with a library there on a
day to day basis will likely be slow, and the addition of network access gives one more possible way
for data corruption to occur. We recommend working with your libraries on locally attached disks
whenever possible and using a NAS primarily for archiving and/or backups. As always, you should
make sure you have an additional backup of the library elsewhere as well.

macOS 14 Sonoma and later There are two issues to be aware of on macOS Sonoma when dealing
with some network and external drives.

1. NAS problems on macOS 14.0-14.3 Starting with macOS 14.0, Photos would no longer create
or open a library on a network drive, instead displaying an error with the only option being to
quit. As of macOS 14.4, this bug appears to be fixed, but proceed with caution if you’re using a
library on a NAS on Sonoma.

2. ExFAT problems Also starting with version 14.0, macOS started to have a number of troubles in
general with ExFAT formatted drives. These problems got worse with macOS 15, making even
basic import attempts fail. PowerPhotos will now refuse to work with a library stored on an
ExFAT drive and recommend that you copy it to a MacOS Extended or APFS drive instead.

3.8 Accessing photos in the “Shared With You”
album from Messages

The Messages app has a “Shared With You” setting that is enabled by default which will make
photos and videos sent to you via Messages appear in your Photos library. This page describes how
these photos/videos appear in Photos and PowerPhotos, since not all the interactions are obvious.

If “Shared With You” settings is enabled in Messages, then the photos you receive from other
people will show up in a “Shared With You” album in the Sharing section of the album list in Photos.
This album will only appear when viewing the system photo library, not any other libraries. If you
disable the setting in the Settings window in Messages, then the album disappears. That part’s
pretty simple.

Where it can get confusing is that Photos can also show those shared photos inline by date with all
the other photos in your library when you’re browsing through the “All Photos” view. Those photos
show with a little “message bubble” badge in the lower left, and if you view the photo full size, it will
show you who it came from in a little control near the top of the photo. This is controlled by the View
> Shared With You menu item in Photos. If you use that to disable showing photos shared from
Messages, then they will no longer appear alongside other photos in your library.

When that setting is active, the shared photos aren’t actually in your library, they’re just displayed
alongside all the other photos in your library. In this state, the photos won’t show up in PowerPhotos
at all.

Then, if you open one of those shared photos, there’s a “Save Shared Photo” button up in the
toolbar. If you click that, then the photo is actually saved to your library and will appear in
PowerPhotos as well. Photos can also be saved this way by clicking the little “down arrow” button
next to them in the Messages app. The photos will continue to appear in the “Shared With You”
album, but will no longer have the “message bubble” icon displayed in the corner of the photo.



So, if there are certain photos that you see displayed in Photos but not in PowerPhotos, those may
be photos that were shared via Messages but have not been specifically saved to the Photos library.

3.9 Opening libraries with the PowerPhotos status
menu

PowerPhotos provides a global status menu that appears in the icons on the right hand side of your
menu bar at the top of the screen. You can enable the PowerPhotos status menu by opening the
settings window in PowerPhotos and checking the “Show PowerPhotos in menu bar” checkbox. The
menu item will remain in the menu bar, even after restarting your Mac. To remove the menu, uncheck
the “Show PowerPhotos in menu bar” checkbox.

Clicking on the PowerPhotos status menu will show you a list of all the libraries you have in
PowerPhotos. Selecting a library from the list will quickly open that library up in Photos for you to
view and edit. This menu can remain in the menu bar even when PowerPhotos isn’t running, giving
you fast access to all your libraries at all times.

Login Items The System Settings app has a Login Items & Extension section (located under
General) that lets you control what apps have permission to launch background tasks at login. If you
enable the PowerPhotos status menu, PowerPhotos will appear in this list in System Settings,
indicating that is has permission to open its helper app (called PowerPhotosMenu) in the
background, which controls the status menu.

Once PowerPhotos has been granted permission here, it will remain visible in the Login Items list
even if you later turn off the PowerPhotos status menu in the PowerPhotos settings window. Its
presence in the list only indicates that it has permission to launch its helper in the background, but
does not necessarily mean that the helper is actually running. If you want to see whether the helper
is running, open Activity Monitor and search for “PowerPhotosMenu”. This is the only persistent
background process that PowerPhotos launches, and PowerPhotos will not run anything else in the
background after the main PowerPhotos app has been quit.



4. Viewing and editing your Photos libraries

4.1 Browsing photos

The grid view of the photo browser allows you to look through your photos much like you do in
Photos, with your photos arranged in a grid, showing a small preview of each photo with some basic
information below the photo itself. The slider in the toolbar allows you to change the size of the
photos, and selecting an individual photo will display that photo’s information in the inspector pane
on the right hand side of the window.

You can customize the appearance of the grid view by using the various commands available in the
View menu. These include:

Photo Titles: toggles on/off the photos’ titles, displayed just underneath the photo.

Show Subtitle: allows you to add a second line of information displayed below the title of each
photo. You can choose from caption, date, dimensions, filename, keywords, kind, place, or size.

Sort By: allows you to specify what attribute the photos should be sorted by. The “manual”
option will display an album’s photos in the same order you’ve arranged them in Photos.



In addition to the Photos-style grid view, PowerPhotos also provides a list view, which is useful when
you’re more interested in looking through your photos’ attributes, such as keywords, sizes, captions,
and so forth. You can switch between grid view and list view using the control in the toolbar in the
upper right.

You can customize the appearance of list view using the commands available in the View menu.
These include:

Show Columns: allows you to add or remove columns from the list. You can choose from
caption, date, dimensions, keywords, kind, place, or size. You can also control-click on the
column headers of the list view as a shortcut to access the same menu.

Sort By: allows you to specify what attribute the photos should be sorted by. The “manual”
option will display an album’s photos in the same order you’ve arranged them in Photos. You can
also sort the list by clicking one of the column headers at the top of the list.

4.2 Viewing full size photos

In both grid view and list view, PowerPhotos provides a few different options for seeing the full size
version of one of your photos.

If you double click a photo, or select one or more photos then hit the space bar, that will expand the
photo to fill the window so you can view it in more detail. When viewing an individual photo, you can
use the following gestures and keyboard commands:

Viewing the next/previous photo: Pressing the left or right arrow keys on the keyboard will



navigate to the previous or next photo in the selected album, respectively. You can also swipe
with two fingers on a trackpad left or right to navigate between photos.

Zooming in/out: You can use a two finger pinch on your trackpad to zoom in on a photo to view
it in greater detail, as well as using the zoom slider control in the window’s toolbar.

Panning: Once you’ve zoomed in, you can drag two fingers on your trackpad to pan around the
photo and view different parts of it.

Playing a video: If you’re viewing a video, a set of controls will be shown that let you play,
pause, and skip to different parts of the video. Pressing option-space will also let you
play/pause the video.

Dismissing the photo: When you’re done viewing the photo, you can press the space bar,
double click, or do a two finger swipe down to dismiss the photo and return to the photo
browser.

If you want to do something with a particular photo in Photos itself, control-click on the photo, and
choose “Reveal in Photos”. That will open up that library in Photos and select the image in Photos’
main window, so you can then do whatever you want with it.

4.3 Viewing libraries in separate windows

In addition to browsing your photo libraries in the main PowerPhotos window, you can also open
individual libraries in separate windows. This lets you view different libraries side by side, and set up
drag and drop photo/album copies between windows.

To open a library in a separate window, select the library and select File > Open Library in Separate
window, or control-click on the library and select Open Library in Separate window from the menu
that comes up. You can also option-double click a library to open it in its own window.

Library windows can also be combined into a single window with tabs for each library. Start by
opening multiple libraries in their own window, then select the Window > Merge All Windows menu
item. This will combine the separate library windows into a single window with tabs for each library.

Because the main window is still crucial for many functions of PowerPhotos, PowerPhotos will
automatically quit when the main window is closed. If you like having libraries open in separate
windows and want to keep them open between launches, open System Settings, go to the Desktop
& Dock section, and uncheck the box labelled “Close windows when quitting an app”.

4.4 Searching your libraries

PowerPhotos provides powerful search functionality that lets you search either a single library or
multiple libraries to find the photos you’re interested in. To start a search, press command-f or click
the magnifying glass icon in the upper right part of the PowerPhotos window.



Search queries

This brings up the search bar where you can configure your search query. The first menu lets you
select a search criterion, such as filename, date, file size, etc. Each criterion will display different
options, letting you choose whether you want a search to match exactly, look for prefixes or
suffixes, or values that are greater or less than the entered value.

The “+” button on the far right lets you add another criterion to your search query, so you can
narrow down your results based on more than just one search term. Selecting “All” of the following
conditions apply will only display photos that match every criteria you’ve set up (a logical “and”
operation), and selecting “Any” will show any photo that matches at least one of your criteria (a
logical “or”).

You can also make nested searches by holding down the option key, which will make the “+” change
to “…”. Clicking it will create a new “any/all” row that lets you nest more search criteria, creating as
complex search query as you like.

Each time you edit your query and press return, PowerPhotos will perform the search and show you
the results. The search will be restricted to whichever album you have selected in the album list, so
if you want to search the entire library, make sure the main “Library” album at the top of the album
list is selected.

Multi-library search

PowerPhotos also lets you run your search on multiple libraries at once. To do so, click the menu
next to “Search in” in the upper left, and that will let you select multiple libraries to perform the



search in. When searching multiple libraries, the album list will be hidden, and the photo browser will
display the combined results of the search in all the selected libraries. The total number of items
found will be displayed in title bar of the window, and the count of items found in each individual
library will be shown in the library list to the right of that library’s name.

Saved searches

Once you have a search query set up, you can save that query to reuse later by clicking on the
“Saved Searches” menu in the upper right. The search will be added to the menu, so you can later
select it from the menu to re-run the saved search. The libraries being searched will be saved along
with the search query itself, so re-running a saved search will search the same set of libraries as
when you first created it. If you select a saved search and make further changes to the search query,
those changes will be automatically saved as you make them. The “Managed Searches” item in the
saved searches menu will bring up a window that lets you delete and rearrange your saved searches.

Library indexing

PowerPhotos performs fast searches by first indexing the library and storing the results in a
database that can return results very quickly. The first time you perform a search in a particular
library, you may see a message that reads “Indexing library…” for a while before the search can be
performed. This process can take a while, but it only needs to be performed once per library. After
the initial index is built, it will be updated incrementally with any further changes made to the library.

Search criteria



The following criteria are available for building your search queries. For any searches where you
enter text, the search matches its result using a case insensitive search. For brevity, the term
“photo” is used in the descriptions below, but unless otherwise stated, videos will be matched as
well.

Album: Any photo that belongs to an album whose name matches what you enter will be
included in the result. There are two additional options available as well: the “is any” option will
include any photos that belong to at least one album in the library, and “is none” will include any
photos that don’t belong to any albums in the library.

Caption: Includes photos whose captions match the entered text.

Date Added: Includes photos whose date added (i.e. the date the photo was imported into the
library) match the given value.

Date Captured: Includes photos whose capture date (i.e. the date the photo was originally
taken) match the given value.

Duration: Includes videos whose duration is greater or less than the entered value. This criteria
only matches videos, and never includes photos.

Edited: Includes photos that have been edited within the Photos library.

Favorite: Includes photos that have been marked as a favorite.

File size: Includes photos whose file size is greater or less than the entered value. The file size
of the original photo that was imported into the library is used for this comparison, and does not
include the sizes of other parts of the photo, such as the video component of a Live Photo or
the edited version of a photo.

Filename: Includes photos whose original filename matches the entered value. This search
does include the filename extension, e.g. “.JPG”

Format: Includes photos that match the selected file format. The most common formats used in
Photos are included in the list to choose from, and some formats will match multiple file
extension, e.g. the “RAW” format matches any RAW formats supported by Photos. If you want to
search for a more specific format or one not included in the list, you can use the “Filename”
criterion to search by file extension.

Height: Includes photos that match the given height in pixels.

Keyword: Includes photos that contain a keyword that matches the entered value. Use the
“Equals” operator to find photos that have a keyword that’s exactly equal to the entered value.
“Contains” will find photos where a keyword contains the entered value as a substring. The “is
any” option will include any photos that contain at least one keyword, and the “is none” option
includes photos that have no keywords assigned.

Media Type: Includes photos that match a special media type. You can specify to only include
photos or only videos, or choose one of the types grouped together by the special “Media
Types” albums in the library, e.g. selfies, panoramas, screenshots, etc.

Megapixels: Includes photos that are greater or less than the entered number of megapixels.
One megapixel equals 2^20 pixels (1,048,576), and the megapixel value of a given photos is
calculated by multiplying its width by its height in pixels.

Place: Includes photos whose place name matches the entered value. The “is assigned” option



will include any photos that has a latitude and longitude assigned to it, and “is not assigned” will
match all photos that have no latitude or longitude assigned.

Referenced: Includes photos that have been imported as referenced photos.

Title: Includes photos whose title match the entered value.

Width: Incudes photos that match the given width in pixels.

4.5 Managing albums

PowerPhotos lets you perform many of the same operations with albums as you can in Photos itself.
All of the following operations can be undone by pressing command-z or selecting Edit > Undo.

Creating a new album To create a new album, press command-shift-n or select the Image > New
Album menu item. If you have a group of photos already selected, the album will be created with
those photos already added to it, otherwise the new album will start empty.

Creating a folder You can create a folder in your album list by pressing command-option-n or
selecting the Image > New Album Folder menu item.

Renaming an album You can click on a selected album’s name to start editing it, or control-click on
an album and choose “Rename Album” from the menu that appears.

Moving albums You can select one or more albums in the album list and drag them to another
location in the album list to move them there. You can hold down the command or shift key while
clicking to make a multiple selection.

Deleting albums Select an album and press command-delete to delete it, or control-click the
selected album(s) and choose “Delete Album” from the contextual menu.

Note that smart albums cannot be created using PowerPhotos. To create a smart album, first open
the library in Photos and use the File > New Smart Album menu item there.

4.6 Managing photos

PowerPhotos lets you import photos, rearrange your photos in albums, and delet photos much like
you can do in Photos. All of the operations below except for importing can be undone by pressing
command-Z or selecting the Edit > Undo menu item.

Importing photos You can import photos into a library either by selecting Library > Import Photos…
or by dragging the photos/folders you want to import from the Finder and dropping them into
PowerPhotos. Read Importing Photos for more details on how importing works.

Adding photos to albums You can select and drag photos/videos in PowerPhotos and drop them
onto an album in the same library to add those photos to the album. Note that if you’re dragging the
photos between two different libraries (e.g. if you have one library open in a separate window), this
will copy the photos from one library to the other. You cannot drag and drop photos from the Photos



app and drop them into PowerPhotos, or vice versa - all photos drags must take place within a
single app.

Moving photos between albums If you want to move photos from one album to another (removing
them from the source album and adding them to the destination album), hold down the command
key while dragging the photos. The cursor will change to indicate a move operation. When you drop
the photos, they will be added to the destination album and removed from the album you dragged
them from. This only works when dragging from a regular album - you cannot move photos from
smart albums or the main Library view, since those views don’t support removing photos.

Removing photos from an album To remove photos from an album, select the photos and either
press the delete key or use the Image > Remove Photos from album… menu item. Removing photos
this way only removes them from the album you currently have selected, and will not delete the
photos from the library as a whole, so those photos will still appear when you select the main
“Library” album at the top of the album list that shows the entire contents of the library.

Delete photos from a library If you want to delete photos from a library entirely (including all the
albums they belong to), select the photos in PowerPhotos then press command-delete, or select the
Image > Delete Photos… menu item. You’ll be asked to confirm the deletion, and if you allow it, the
photos will then be deleted from the library.

4.7 The inspector

On the right hand side of the window, you’ll find the inspector, which will display detailed
information about whatever object you have selected in the rest of the window. You can use this to
see information for libraries, albums, or photos. The following information is displayed here:

Libraries: The library’s name, version, size, and location on your computer.

The size shown is for the entire library package, including all of Photos’ own data files. This should
normally match the size reported for the library in the Finder. Note that this size will be larger than
the size shown in Photos itself, which only adds up the space taken up by the photos themselves.

Albums: The album’s name and description, and the number and size of the photos it contains.
Note that the size calculated for an album only includes the size of the original photos/videos in the
album, and doesn’t take into account extra data like Live Photo videos, edited versions of photos,
thumbnails, and other caches.

Photos: The selected photo’s attributes, including:

Filename: The filename of the photo when it was imported into the library

Kind: The photo’s kind, e.g. JPG, PNG, RAW, etc.

Size: The photo’s file size. Note that this only indicates the size of the original photo, and does
not include any data stored for things like edited versions, Live Photos, and so forth

Dimensions: The height and width of the photo in pixels. If the photo has been edited, this
shows the edited dimensions, not the original photo’s dimensions.

Albums: If the photo belongs to any albums, shows the names of each album the photo belongs
to. Note that you can control-click on a photo to reveal it in a particular album if you want.



Date Captured: The date the photo was originally taken. This date is embedded in the photo’s
EXIF data, and can be adjusted in Photos using the Image > Adjust Date & Time menu item. This
is also the data that photos uses when sorting the library by date.

Date Added: The date the photo was added to this library. This is often the same as the capture
date (e.g. when synced via iCloud Photos), but can be different if the photo was imported a
while after it was taken, or copied from one library to another.

Date Modified: The date the photo was last modified. This date will only appear if the photo was
edited after being added to the photo library.

Title: The photo’s title. Photos have no title when first imported into a library, in which case
Photos and PowerPhotos display the photo’s filename in grey text in place of the title. You can
edit the title either in PowerPhotos or Photos.

Keywords: The photo’s keywords, which can be edited in either PowerPhotos or Photos.

Caption: The photo’s caption, which can be edited in either PowerPhotos or Photos.

4.8 Editing photo metadata

The inspector in PowerPhotos also allows you to edit your photos’ titles, keywords, and captions
right from within PowerPhotos. The inspector is designed to allow you to quickly enter metadata for
lots of photos sequentially without ever having to take your hands off the keyboard. Editing can be
done both when browsing photos in grid view or list view, or when viewing a photo in full size.



When you select a photo in the photo browser, you’ll see that there are three fields in the inspector
that can be edited: the photo’s title, keywords, and caption. Editing is straightforward: click in the
field you’d like to edit, type in the new text you want, then press the tab key to advance to the next
field or photo.

Quick editing

If you are in the last field in the inspector and press the tab key, PowerPhotos will automatically
select the next photo in the browser and put the keyboard cursor back in the first field in the
inspector. This way, you can quickly enter values and press the tab key after each one, and you will
advance through all the photos in the album you currently have selected.



The three metadata fields each have a lock icon next to them. Clicking this icon will “lock” that field
so that it’s no longer editable. This can be convenient if there are one or more fields that you’re not
interested in editing at all. For example, let’s say you just want to add captions to a whole bunch of
photos in a particular album. If you lock the title and keyword fields, leaving only the caption field
editable, then after you enter a caption for each photo, just a single press of the tab key will send
you right to edit the caption of the next photo, letting you quickly cycle through and enter
information for lots of photos.

Metadata fields

Title: When a photo is first imported into Photos, it does not have a title assigned to it. Both
Photos and PowerPhotos will instead display the photo’s filename in grey text underneath the
photo whenever it has no title. If the photo does have a title, then that will be displayed
underneath the photo in black text (or white text when running in dark mode).

Keywords: A photo can have multiple keywords assigned to it. To add keywords to a photo in
the inspector, start typing the keyword you want to add. PowerPhotos will autocomplete your
typing with any existing keywords in the library that match what you’re typing. If you have typed
a keyword and want to start a new keyword, press the comma key and PowerPhotos will finish
that keyword and let you start typing a new one. Note that keywords can contain spaces, so if
you type two words, then type a comma, you’ll end up with a single keyword with a space in it.
You can edit an existing keyword by double clicking on it.

Captions: The caption field of a photo is not utilized for much within Photos, but serves an an
additional place where you can enter information for a photo. The most common use for
captions is to give additional text that can be used as a search term in the library to find photos.
Photos will also automatically suggest using a photo’s caption when posting the photo to a
shared album. Due to technical limitations, when you edit a caption in PowerPhotos, the library
you’re editing will need to be opened up in the Photos app in the background. You may also see
the Photos icon bounce in the dock once each time you edit a caption - this is a purely visual
bug and doesn’t indicate anything is wrong.

Titles, keywords, and captions are currently the only fields that are supported for editing from
PowerPhotos. Photo capture dates can be modified by opening the library in Photos and using the
Image > Adjust Date & Time menu item. Locations can be changed in Photos by pressing command-i
to bring up the Info window. Other metadata fields (e.g. filename, date added, etc.) cannot be edited
in either Photos or PowerPhotos.

Keyboard shortcuts

While editing photo metadata in the inspector, you can use the following keyboard shortcuts: Tab:
advances to the next editable field, or if the keyboard cursor is already in the last field, advances to
the next photo in the photo browser. Shift-tab: advances to the previous editable field, or if the
keyboard cursor is already in the first field, advances to the previous photo in the photo browser.
Option-tab: advances to the next photo regardless of what field you’re editing. This can be handy
for skipping through photos without having to tab through multiple editing fields each time. Option-
shift-tab: advances to the previous photo regardless of what field you’re editing.



4.9 Batch editing metadata

In addition to editing photo metadata one at a time, PowerPhotos allows you to select an entire
batch of photos and apply titles, keywords, or captions to all the selected photos at the same time.

Titles and Captions

When editing titles or captions, you can build a custom template that will be applied to all the
selected photos. This template can consist of pieces of text you type combined with tokens that
represent attributes of each individual photo. This allows you to include things like a photo’s capture
date, import date, dimensions, file size, it’s existing title/keywords/caption, an incrementing counter,
and more as part of the new title/caption for each photo.

To create your template after selecting the photos you want to edit, drag one or more tokens
(represented by blue rectangles) up into the template field. You can also type your own text before,
between, and after the tokens if you want the same text applied to every photo. Here is one
example:

In this setup, we are giving every photo the title “Jezebel” followed by the year, month, and day that
the photo was taken. So for example, for a photo taken on January 7th, 2014, the title would be
“Jezebel-2014-01-07”. If the next photo was taken January 8th, 2014, then that photo will get the
title “Jezebel-2014-01-08”, and so forth.

Read batch edit tokens for more details on the available tokens that can be added to your templates.



Keywords

When you select a batch of photos you want to edit the keywords of, PowerPhotos will start by
counting up the keywords that are already assigned to the photos and displaying those in the
inspector. Each keyword that occurs in at least one of the selected photos is listed with a number
next to it indicating how many photos currently have that keyword.

Next to each keyword are +/- buttons. Clicking + will tell PowerPhotos to add that keyword to all the
photos, and - will remove the keyword from all the photos. You can also use the menu just below
that list to add another keyword to all the photos, either picking an existing keyword from the library,
or creating a new keyword.

Preview

Before applying any changes to your photos, PowerPhotos offers the opportunity to preview what
those changes will look like. While you edit your batch editing setup in the inspector, PowerPhotos
will display what the new titles/captions/keywords for each photo will be in green, bold text as the
subtitle underneath the photos in the photo browser to the left. If a particular photo’s
title/caption/keywords will end up remaining the same after the edit, then its subtitle will not be
shown in green. The preview updates live as you change your editing setup, so you can quickly
iterate and see what your results will look like.

Applying changes

Once you are ready to apply the changes shown in the preview, click the “Apply” button, and
PowerPhotos will proceed and change the photos’ metadata. After it’s done, the newly altered
metadata will be shown underneath each photo, and will no longer be shown in green & bold text,
indicating that these are now the real, new values for your photos. Undo is not supported for batch
edit changes.

4.10 Batch edit tokens

When configuring a batch edit template, PowerPhotos provides a number of tokens that can be
added to the template that let you insert pieces of information about a photo into the new title or
caption that is being assigned to that photo. Below is a list of the tokens PowerPhotos provides and
how they work

Filename/title

These tokens allow you to include the photo’s original filename or its existing title as part of the new
title/caption you’re assigning to your photos.

Filename: Inserts the photo’s original filename, without the file extension. For example, if a
photo’s filename was “IMG_1234.JPG”, this would insert the text “IMG_1234”.



Title: Inserts the photo’s current title, if it has one. This can be useful if you want to add text to
the title your photo already has.

Title or filename: If the photo has a title assigned, then this will insert the photo’s title,
otherwise it will fall back to inserting the filename instead.

File extension: Inserts the photo’s file extension, e.g. “JPG”, “PNG”, etc. This does not include
the “.” between the filename and extension, so if you want that included, type “.” into the
template field.

Counter: This is an incrementing counter that will insert a different number to each photo’s title,
starting at 1 for the first photo and counting upwards. If you want to have your count padded
with a specific number of zeroes, click the token and choose your padding option from the
menu that comes up, e.g. selecting “0001” will pad the number to 4 digits.

Attributes

These tokens insert various attributes of the photo as part of the new title/caption.

Caption: Inserts the photo’s existing caption, if it has one.

Keywords: Inserts the photo’s keywords, separated by commas.

Height: Inserts the photo’s height in pixels

Width: Inserts the photo’s width in pixels.

Date tokens

These tokens let you insert components of one of the dates associated with the photo. The dates
available are:

Date Captured: This is the date that the photo was originally taken, and is the date used for
sorting when you browse through the photos in your library.

Date Added: This is the date that the photos was added to the Photos library. This is very often
the same as the capture date, e.g. when you take a photo on your iPhone, and it is immediately
added to your library. In some cases it can be different from the capture date, such as files
imported from the Finder or copied from another library.

Current Date: This is the current date at the time you’re performing the batch edit.

Location

These token insert information based on the geolocation of the photo, if it has one. If the photo has
no location assigned to it, these tokens will all insert nothing.

Place Name: The name of the place assigned to the photo, the same value shown in the “Place”
inspector field for the photo.

Latitude: The photo’s latitude, e.g. “+38.35”

Longitude: The photos’s longitude, e.g. “-119.43”



For each date, you can insert individual components of the date, including the year, month, day,
weekday (e.g. “Tuesday”), or time. Each component has different display options available that can
be found by clicking on the token and selecting from the menu that appears. For example, for month
you can chose from “Sep”, “September”, “9”, or “09”, and so forth.



5. Finding duplicate photos

5.1 Find Duplicates overview

Using the Find Duplicates feature in PowerPhotos consists of three main steps.

1. Searching for duplicates The first step is to tell PowerPhotos what libraries you would like to
search for duplicate photos, and how you would like it to compare photos to determine whether
they are duplicates or not. You can read about this step in “Starting the duplicate finding
process”. Once you start the duplicate finding process, PowerPhotos will perform an analysis of
your photos and try to determine which photos are duplicates of each other. The result of the
analysis is a list of duplicate groups. Each duplicate group contains two or more photos which
have been identified as duplicates of one another. These groups will be shown to you in
PowerPhotos’ duplicate browser.

2. Choosing keepers Next, PowerPhotos will choose a keeper from each duplicate group. You can
customize how keepers are chosen from each duplicate group by choosing a duplicate rule,
which will look at various attributes of the duplicate photos and choose one of them based on
those attributes. A bunch of built-in duplicate rules are included with PowerPhotos, or you can
create your own custom duplicate rule. You can read about this step in “Choosing keepers with
duplicate rules”.

3. Trashing duplicates After choosing which photo(s) you want to keep from each group, the rest
will be marked to be trashed. You can read about this step in “Deleting your duplicate photos”.

5.2 Starting a duplicate search

To begin finding duplicate photos in your Photos libraries, either click the magnifying glass button in
the toolbar, or select “Find Duplicates” from the Library menu. This will present you with a view to
set up your duplicate finding.



There are two areas you need to set up to begin your duplicate search

What to search The Find Duplicates command can search one or more Photos libraries at once,
looking for duplicate photos. To search a library, drag it from the library list on the left into the area
labelled “Choose Libraries to Search”. To remove a library, click the X next to its name.

How to compare photos PowerPhotos bases its search on an algorithm that looks for photos that
are visually identical. This allows PowerPhotos to find duplicate photos even if one copy has been
scaled to a different size, saved as a different file format, or even had minor edits applied to it.

If you wish to further restrict what PowerPhotos considers to be a duplicate, you can select one or
more of the metadata comparison options.

Once you’ve set up your search, click the “Begin Duplicate Search” button in the upper right corner
of the window, and PowerPhotos will begin analyzing your libraries for duplicate photos.

5.3 Duplicate comparison options

When copying photos, merging libraries, and searching for duplicate photos, PowerPhotos uses a
visual matching algorithm to find duplicate photos by analyzing the photo content to find photos
that are visually identical. This will identify cases where the two photos may not be exactly the
same, such as when one copy of the photo is scaled down to a smaller size, has been saved in a
different format, or has had minor edits performed on it.

In some cases, you may want PowerPhotos to be more strict in what it considers to be a duplicate
photo. If you want to narrow down its matches, you can enable one or more of the following options



that will look at other aspects of the photo in addition to the content.

Note: enabling any of these options will only ever decrease the number of duplicates reported. If
you want the most inclusive duplicate search possible, leave all comparison options disabled.

Filename must match: When enabled, PowerPhotos will only match up photos where the
filename of the imported photos is the same. This comparison does not include the file
extension, so for example “IMG_1234.JPG” and “IMG_1234.HEIC” would be considered the same
filename.

First N characters: Enabling this will only look at the first N characters of the filename. This can
be handy when something has been appended to the filename of one of the photos, e.g.
“IMG_1234.JPG” vs. “IMG_1234_2.JPG”.

Date and time must match: Specifies that the date and timestamp of the two photos must be
identical, down to the second. Note that in some cases where one of the two photos has been
assigned a different time zone, this might make photos that would otherwise be duplicates not
get matched up.

File format must match: Normally, PowerPhotos doesn’t care what format each photos is, such
as JPG, HEIC, or PNG, and will just examine the photo content. This means that for example, a
JPG and an HEIC version of the same photo will get matched up. If you don’t want this kind of
match to happen, enabling this option will only match JPG to JPG, HEIC to HEIC, etc.

File size must match: This settings restricts matches only to photos whose original file size is
identical. Use this setting if you only want to match photos that are truly identical, and have not
been resized, edited, or recompressed. This setting is only selectable if the file format option is
turned on, since it doesn’t make sense to compare file sizes of files that are of different formats.

Height & width must match: PowerPhotos’ normal visual comparison algorithm doesn’t care if
one copy of the photo is larger than the other, e.g. it will match a smaller thumbnail copy of a
photo to the original as a duplicate. If you want to restrict matches to only photos that have the
exact same pixel count for height and width, enable this option.

5.4 Browsing your duplicates

Once PowerPhotos has determined which photos are duplicates, it will display those duplicates to
you so you can see what it has found.



Your duplicate groups are displayed in a grid, with each group separated from the others. Just like
when browsing a regular library, you can zoom in and out on the photos, select an individual photo
to see its attributes in the information pane, and so forth.

Once your duplicate rule has successfully chosen keepers from your duplicates, icons will appear
above each photo.

- indicates the photo has been chosen as the keeper for that duplicate group

￼- indicates the photo will be trashed

The “View Log” button will display information logged by PowerPhotos during the duplicate analysis.
This lets you see in more detail the paths of the photos that were identified as duplicates, which
photos have been marked as keepers, and which ones will be marked to be trashed.

5.5 Choosing keepers with duplicate rules

PowerPhotos uses a rule-based system to choose a keeper from each group of duplicate photos.
The keeper will typically be the one photo that you want to keep around, with the rest of the
duplicates getting moved to the trash, or having some other action performed on them. You can
choose from several built-in duplicate rules using the pop-up menu down at the bottom of the
window.



Once a rule has been chosen from the pop-up menu, PowerPhotos will evaluate all the duplicate
groups based on that rule. In the duplicate browser, you will see a checkmark above whichever
photo from each group has been chosen as the keeper.

The built-in duplicate rules include:

Keep PowerPhotos recommendations: this is a good default rule that should work well for
most setups. It prefers to keep favorited photos, edited photos, HEIF over JPG, larger photos
over smaller ones, photos that belong to albums, and photos that have been assigned
keywords, captions, or titles. If you want to create a custom rule, a good place to start might be
by duplicating this rule and making your own adjustments to fit your collection.

Keep favorite photos: if you have marked any photos in your library as a “Favorite”, the marked
photo will be chosen as the keeper, and other photos as nonkeepers.

Keep the largest duplicate: compares the file size of each duplicate photo and keeps
whichever one is the largest. This is useful if you have some duplicates that have been scaled
down from the original, so you can keep the largest copy and get rid of the smaller ones.

Keep photos that belong to an album: if you have some photos included in albums in your
library, and others that don’t belong to any album, this rule will prefer keeping the copies of the
photos that are part of an album and getting rid of those that aren’t.

Keep RAW photos: this can be helpful if your library has RAW and JPG versions of the same
photo imported side by side. Run your duplicate search with the “Match on filename + date” and
“Allow different formats” options enabled, then this rule will select the RAW version of each
photo to keep, and discard the JPGs. If you wish to keep the JPGs instead, create a duplicate
copy of this rule and change the format to keep to JPG instead of RAW. (note: this will not work
to separate RAW+JPG pairs that were imported as single item into Photos)

Keep duplicates in library X: this rule is useful if you are searching more than one library at a
time. If two duplicates are found in different libraries, one of these rules will appear for each
library you have included in the search (with the “X” above being the name of each library).
Choosing the rule will prefer to keep the photos in the selected library and mark the photos
from the other libraries as nonkeepers so you can get rid of them.

Disable auto choosing: this will disable auto choosing entirely, and all photos will initially be



marked as keepers. This lets you go through and manually select the photos you want to trash.

Editing rules

The built-in rules are a good start, but since everybody’s photo collection is unique, you may need
to create a custom duplicate rule to choose keepers according to what makes the most sense for
your own photos. To create a custom rule, click the rules pop-up menu and select “Edit Rules…”
from the bottom of the menu. This will present you with the following window:

You can view (but not edit) the built-in rules to see how they are implemented. To create your own
rule, click the gear button in the upper right and select “New Rule” from the menu that appears. If
you’d like a rule similar to one of the built-in rules, select that rule from the pop-up menu, then click
the gear button and select “Duplicate Rule” to make a copy of that built-in rule. You can specify a
name for your new rule by typing it in the “Name” field.

Each duplicate rule is made up of one or more criteria that you’d like to use to compare the photos in
each duplicate group. By evaluating these criteria, one or more photos from the group will be
chosen as the keeper from that group. The criteria available to compare include the photos’ rating,
modification date, size, format, and much more. See the Criteria Details section for more
information.

Because in many cases the duplicate photos will also have identical values for many of these
attributes, you can specify multiple criteria to evaluate the photos by. If the first criteria is identical
for some or all the photos in the group, the evaluation will then proceed to the second criteria, and
so on, until they have all been evaluated.



How rules are evaluated

In the example above, we have three photos that have been identified as duplicates by PowerPhotos,
and the four criteria from the rule displayed above that were specified to evaluate the duplicate
photos.

The first criterion says to choose whichever photo has a custom title. However, none of the photos
have a custom title set, so this criteria does not choose any photos, and evaluation continues to the
next criteria.

The second criterion says to prefer RAW photos over other formats such as JPG. There are two RAW
photos in the duplicate group, and one JPG, so PowerPhotos will not choose the JPG as being the
keeper. This leaves the two RAW photos as possible keepers, and we proceed to the next criterion.

The third criterion says to prefer photos that have been favorited. The photo in the middle is marked
as a favorite, so that photo is choosen by PowerPhotos as the keeper.

Since we have now narrowed down the group to a single photo to keep, the fourth criteria is not
needed, and is skipped. The middle photo is chosen as the keeper and will appear with a checkmark
over it in the duplicate browser, and the other two photos are marked to be trashed.

Single vs multiple keepers

By default, only a single photo is marked as a keeper from each duplicate group. If your duplicate
rule does not narrow things down to just a single photo, then PowerPhotos will pick one of the
remaining photos for you as the keeper. However, if you uncheck the “Always choose only a single
keeper” checkbox, then all the photos that make it to the end of criteria evaluation will be marked as
keepers.

For example, let’s say you have a duplicate group with two photos from “Library A”, and two photos



from “Library B”, and that you have a duplicate rule set up with a single criteria that says “Library is
Library A”. Both photos from Library B will be eliminated by the criteria, leaving just the two photos
from Library A. If “Always choose only a single keeper” is checked, then PowerPhotos will only mark
one of the two photos from Library A as a keeper; if it is unchecked, then both photos from library A
are marked as keepers.

** Incomplete items ** In certain cases, you may see an additional checkbox labelled “Never choose
incomplete photos as keepers”. This checkbox will appear when PowerPhotos has detected that
some of the duplicate photos are “incomplete”, meaning they’re missing some part of their data. You
can read in more detail about incomplete items here. When this box is checked, PowerPhotos will
always choose a complete photo as the keeper over an incomplete photo, overriding the decision
made by the duplicate rule.

5.6 Criteria details

The following is a list of the criteria that can be used in duplicate rules to select photos from among
a set of duplicates.

Album: chooses photos based on whether they belong to one of the albums in the Photos
library. This can be used in cases where you have some duplicate photos, but one instance of
the photo has been added to an album, and you want to make not to remove the copy of the
photo that has been added to an album. Note that this only looks at the contents of “regular”
albums, not smart albums.

Caption: if you have entered custom captions in Photos for your photos, this criterion lets you
choose duplicates based on the length of that caption, or whether the caption contains a
particular piece of text.

Date: chooses based on the date the photo was taken.

Edited: chooses based on whether the photo has been edited.

Favorite: chooses based on whether you’ve marked the photo as a “Favorite” in Photos.

File size: chooses either the smallest or largest file in the duplicate group. Note that for edited
photos, this will use the size of the original version of the photo.

Filename: chooses based on the length of the original photo’s filename, or whether the filename
contains a piece of text that you enter. This can be handy to choose things like “IMG_1234.JPG”
over “IMG_1234 (1).JPG”.

Height & width: chooses based on the pixel dimensions of the photo. The height and width will
be multiplied together and that result used to do the comparison.

Format: allows you to prefer one format of photo over another. For example, if you have some
photos for which you have both a HEIC and a JPG version, you can opt to always choose the
HEIC over the JPG.

# of keywords: chooses according to how many keywords have been assigned to each photo.

Keyword: chooses based on whether the photo has been assigned a particular keyword that
you specify.



Library: chooses based on what library they belong to. If you are searching across multiple
libraries for duplicates, this criteria can be useful if you prefer to keep photos from one library
over another library.

Live Photo: chooses based on whether a photo is a Live Photo or not (photos with their
“liveness” manually disabled are not considered to be Live Photos)

Modification date: chooses based on the date each photo was last edited.

Place: chooses photos according to whether they have a geographic location assigned to them
in Photos.

Title: chooses based on whether the photo has been given a custom title or not. Photos assigns
a default title to each photo base on the photo’s filename (e.g. “IMG_0001”), but if you have
typed in your own titles for some photos, this can help preserve the photos that have those
custom titles. You can also choose based on whether the title contains a particular piece of text.

5.7 Choosing keepers manually

While duplicate rules provide a very flexible way to decide which duplicate photos to keep and get
rid of, sometimes you may still want to make some decisions yourself, rather than leaving everything
up to the automated rules.

You can do this by selecting one or more photos, then clicking either the “Keeper” or “Trash” button
at the bottom of the window to mark your selection to either be kept or trashed. Alternately, you can
also control-click a photo and use the contextual menu, or press the return key to toggle a photo
between keeper and trash.

Note that while duplicate rules will always leave at least one keeper in each duplicate group, if you’re
changing actions manually, it is possible to mark all photos from a group to be trashed. Be careful
when doing this, since you want to be sure you’re not deleting all copies of a photo unless you really
want to get rid of them all.

If you would like to review all selections manually, but would prefer not to have to do it all in one
sitting, you can do so like so:

1. Run your duplicate search, then in the “Auto Choose Keepers” section, select “Disable auto
choosing” from the pop-up menu. This will initially mark all photos as keepers, so nothing is
marked to be trashed.

2. Go through and do your manual review until you’ve done enough, then click “Trash Duplicates”
to trash the photos you’ve marked to trash.

3. The next time you want to review more, run the same search again, then scroll down to where
you left off last time and review another batch. You can repeat this process as desired until
you’ve reviewed all your photos.

5.8 Deleting your duplicate photos



Once you’ve finished choosing which photos to keep and which to trash, click the “Trash
Duplicates” button in the upper right corner to get rid of your duplicate photos. You can specify how
to deal with your duplicate photos in the “Options” section at the bottom of the window.

Delete duplicate photos

PowerPhotos can directly delete the duplicate photos from your library for you, so there are no
additional steps you need to take. You will see an additional confirmation warning displayed by
macOS before the deletion is finalized.

Keep albums intact

When deleting photos from your library, it’s possible that some of those photos currently belong to
one or more albums in that library. Deleting the photos will also remove those photos from their
albums, but with this option enabled, PowerPhotos will replace each deleted photo with the
corresponding keeper photo from the same duplicate group. The end result is that all your albums
will remain intact with the same number of photos even after doing your duplicate deletion.

Note that this option only applies when the trashed photo and the keeper belong to the same library.
If your duplicate search spans multiple libraries (let’s call them “Library A” and “Library B”), then if
the photo being trashed is in library A, and the keeper is in library B, then any albums in library A
that contained the trashed photo will not have the photo be replaced.

Add duplicates to album

If you’d rather not delete your photos right away, you can have PowerPhotos collect them into an
album for you instead.

PowerPhotos will create an album named “PowerPhotos duplicate trash” in your Photos library and
populate it with all the photos that have been marked to be trashed. PowerPhotos will then walk you
through the steps needed to delete the photos from the library. Note that all these steps are done in
the Photos app, and not from within PowerPhotos.



1．Select Trash Album Bring Photos to the front and select the “PowerPhotos duplicate trash”
album in your album list. PowerPhotos can perform this step for you by clicking the “Select the
album for me button”.

2．Select All Photos Select all the photos in the “PowerPhotos duplicate trash” album, either by
pressing command-a or choosing “Select All” from the Edit menu.



3．Delete Photos Press command-delete to move all the photos into the “Recently Deleted” album,
removing them from the library. Note that just pressing the delete key alone will only remove the
photos from the album, and not delete the from the library.



After deletion Once the photos have been deleted, they will remain in the “Recently Deleted” album
until Photos permanently deletes them in 40 days. This gives you a chance to “undelete” them for a
while in case you change your mind. You can do that by selecting the “Recently Deleted” album,
selecting the photos you want to undelete, and clicking the “Recover” button. If you want to delete
the photos right away to free up disk space, you can instead click the “Delete All” button, which will
delete them immediately and permanently.

5.9 Duplicate tips and tricks

Here are a few tips and tricks that might be helpful when using PowerPhotos to deal with duplicate
photos in your libraries.

Make sure to try out the various duplicate detection options to see which settings work best for your
particular photo collection. For instance, if you are having some photos which you think should be
identified as duplicates but aren’t, make sure you have all the metadata comparison options
disabled when you set up your search. This is the most inclusive, and will identify photos that are
not byte-for-byte matches of each other.

Duplicate rules can be very helpful in eliminating the laborious work of going through all the found
duplicates and picking which one(s) you want to take action on. Some common examples include:

If you’re looking through multiple libraries for duplicates, and would prefer to keep duplicates in
a particular one of the libraries, use one of the built-in “Keep duplicates from library X” rule that
will mark photos from that library as keepers.

If you have multiple copies of photos, but have added more metadata to some copies than
others (e.g. by assigning keywords, identifying faces, etc.), use a rule based on the metadata
that you have assigned to choose the better photos. For example, you could use the “# of
keywords” rule criteria to prefer the photos that you’ve assigned keywords to over those that
you haven’t.

If none of the built-in criteria exactly match a group of photos you want to always keep (e.g.
photos in a particular set of albums, or the results of a complex search), use Photos to assign a
custom keyword to the photos you’re interested in (e.g. tag them with a keyword named
“Keep”). Then, create a custom duplicate rule with a row reading “Keyword is X” where X is the
keyword you assigned to your photos. That will ensure that PowerPhotos keeps the photos you
assigned with that keyword over the other photos in the library.

Nothing will actually be done to your photos until you click the “Trash Duplicates” button when
browsing through them, so you can experiment as much as you like with different rules and
options.

https://support.apple.com/guide/photos/find-photos-by-keyword-pht8d0ad5198/mac


6. Copying between Photos libraries

6.1 Copying albums

When keeping your photos separated in multiple libraries, you sometimes need to copy a set of
photos from one library to another. With Photos, the only way to do this is to manually export the
photos from one library, switch over to your other library, and then manually import them into that
library. PowerPhotos provides a way to copy photos directly from one library to another in one step,
while retaining photo metadata such as keywords, dates, favorites, titles, and descriptions.

To copy albums to another library, select them in PowerPhotos, then drag them them onto the library
you would like to copy them to. PowerPhotos will first collect the information about those photos
from the source library, and then import those photos into the destination library and restore all the
photo information as it was before. If you drag more than one album at once, and a photo belongs to
more than one of those albums, the photo will only be imported once, but will be added to all the
appropriate newly created albums in the destination library.

In addition to dragging albums, you can select albums then control-click on them, and use the
“Copy To” contextual menu item to copy them to another library. You can also open libraries in
separate windows and drag albums from one window to another to copy them across.

Note that you cannot drag albums from Photos itself into PowerPhotos - you must drag the albums
from PowerPhotos’ own window in order to perform a copy. Also, only regular albums and folders



can be copied as-is between libraries. Copying a smart album to another library will copy all the
photos in that smart album, but a regular album will be created in the destination library containing
those photos rather than a smart album. Copying “project” items like calendars, books, and
slideshows between libraries is not supported.

Unregistered users are limited to only copying albums totalling no more than 20 photos.

Moving albums

In some cases, you may want to move albums from one library to another rather than copy them.
You can do this in PowerPhotos by holding down the command key while dragging albums across to
another library, or by control-clicking on the albums and using the “Move To” contextual menu item.

To perform the move, PowerPhotos will first copy the albums and their photos over to the
destination library, then once the copying is done, it will delete the albums and photos from the
library they came from (Photos will prompt you for permission to perform the deletion).

If any of the photos fail to be copied successfully (e.g. a photo is corrupt), then after finishing the
copying, PowerPhotos will ask you whether you only want to delete the photos that were copied
successfully, delete all the photos that you dragged across, even the ones that didn’t get copied, or
don’t delete anything. You can see more detail about which photos failed to copy by clicking “View
Report” in the message that’s shown when the move operation is finished.

6.2 Copying individual photos

In addition to copying albums, you can also drag individual photos from the PowerPhotos image
browser and drop them on another library in your library list to copy the photos and their metadata
over. No albums will be recreated when copying individual photos this way.



To ensure that the extra photo information such as edits, titles, descriptions, keywords, dates, and
favorites will come over, you should drag the photos from PowerPhotos’ image browser, and not
from a Finder window, the Photos app window, or some other program that lets you drag files. If you
drag from somewhere else, they will be treated as regular photos, and the extra information
associated with them from Photos will not be brought into the destination library.

In addition to dragging photos, you can select your photos then control-click on them, and use the
“Copy To” contextual menu item to copy them to another library. Due to the way dragging items in
macOS is implemented, if you intend to copy a large number of photos, the contextual menu will be
a lot faster, as you may experience a temporary hang when you first start a large drag. You can also
open libraries in separate windows and drag photos from one window to another to copy them
across.

Moving photos

In some cases, you may want to move photos from one library to another rather than copy them. You
can do this in PowerPhotos by holding down the command key while dragging photos across to
another library, or by control-clicking on the albums and using the “Move To” contextual menu item.

To perform the move, PowerPhotos will first copy the photos over to the destination library, then
once the copying is done, it will delete the photos from the library they came from (Photos will
prompt you for permission to perform the deletion).

If any of the photos fail to be copied successfully (e.g. a photo is corrupt), then after finishing the
copying, PowerPhotos will ask you whether you only want to delete the photos that were copied
successfully, delete all the photos that you dragged across, even the ones that didn’t get copied, or
don’t delete anything. You can see more detail about which photos failed to copy by clicking “View



Report” in the message that’s shown when the move operation is finished.

6.3 Importing new photos into a library

In addition to copying photos from another Photos library, you can also import new photos directly
into one of your Photos libraries by dragging the photos from the Finder and dropping them onto a
library in the PowerPhotos window. PowerPhotos will automatically open up the library they were
dropped onto and import the photos in Photos for you.

Unlike when copying directly from another library, there will be no additional metadata such as
captions, keywords, etc. for PowerPhotos to copy across, though Photos will still recognize
information embedded in the photos such as the date it was taken. This does still have the
advantage of being more convenient than opening the library manually, plus you can still take
advantage of PowerPhotos’ duplicate detection system when importing photos this way.

Additionally, if the folder you drop has your photos organized into a hierarchy of subfolders,
PowerPhotos will recreate that same folder hierarchy as albums organized into folders in your photo
library.

6.4 Merging libraries

PowerPhotos allows you to merge the contents of multiple libraries together into one, while
preserving all your albums and photo metadata. To begin a merge, click the “Merge Libraries”
toolbar button, or select “Merge Libraries” from the Library menu. This will present you with the
following view for setting up your merge:



There are four main parts to setting up your merge

1. Choose Source Libraries To specify one or more libraries whose contents you would like to
merge into another library, drag the libraries from the library list on the left and drop them onto
the area labelled “Choose Source Libraries”.

2. Choose Destination Library Then, you must specify what Photos library you want to receive all
the photos and other content you’re merging. You can either drag one of your existing libraries
to where it says “Drop destination library here”, or if you wish to start a brand new library
instead, click the “Merge into a new, empty library” button. You will then be prompted to choose
a name and location on your hard drive to store the new library. If you wish to change this
location later, click the “Change location” button to do so.

3. Duplicate Handling When merging libraries, PowerPhotos provides an option to only import a
single copy of any duplicate photos that occur multiple times among the libraries being merged
together. If the “Eliminate duplicates while merging” checkbox is off, then all photos will be
imported, regardless of whether they are duplicates. You’ll almost always want to leave this
option enabled.

The “Duplicate comparison options” gives you control over how PowerPhotos looks for
duplicates in the libraries being merged. You can find details on how these work in the
“Starting A Duplicate Search“ chapter of the manual.

The “Choose which photos to merge by these criteria“ allows you to specify how
PowerPhotos should decide which photo from a group of duplicate photos should be
included in the merged library. You can read more about how these criteria work in the
duplicate rules chapter of the manual.

Note that unlike when using Find Duplicates, the merge process never deletes any duplicate



photos. PowerPhotos is simply using the rules to choose a single photo to import from each
group of duplicate photos. You can read more about how this works in the Handling
Duplicates When Copying section of the manual.

When merging into an existing Photos library, if a group of duplicate photos contains one
photo that is already in the destination library, that photo will always be the one to be kept
rather than a photo from any of the source libraries being merged. The reason for this is
because there is not a reliable way to replace an existing photo with a different one in
Photos, including making sure that photo appears in the correct place in albums, projects,
and other various aspects of the library structure. The best way around this limitation is to
merge into a new library rather than an existing library.

4. Options

Combine contents of albums with same name. This option determines what to do if an
album with a particular name is present in more than one library that’s being merged. For
example, say you’re merging two libraries that both have an album named “Vacation”. If this
option is checked, then a single “Vacation” album will be created in the merged library, with
the combined contents of the two original “Vacation” albums. If unchecked, then each
“Vacation” album will be copied separately, resulting in two albums in the merged library.

Show Preview. By default, PowerPhotos will show you a preview of what the merged library
will look like before it starts the actual merging process. You can disable this preview if you
want PowerPhotos to automatically proceed to performing the merge without needing to
approve it manually.

Copy Metadata/Bursts/Edits/Incomplete items. Lets you control various aspects of what
exactly PowerPhotos will copy over for each photo/video being merged. See more details on
these options in the settings manual page.

Backing up your library

If you choose to merge into an existing library rather than a new one, you’ll be prompted with the
option to make a backup copy of the destination library before proceeding with the merge. This is a
convenience in case you end up wanting to revert back to the library in its pre-merge state.

Merging a large number of libraries

If you have a large number of libraries you wish to merge, it’s recommended that you merge them a
few at a time, rather than all at once. Merging five or fewer libraries at a time will use less memory
and complete more quickly. The end result will be the same as if you had merged all the libraries in
one pass. Merging in smaller batches also gives you the chance to check the merge progress along
the way before proceeding to the next merge.

Once you have set up your merge, click the “Preview” button to advance to the preview screen,
where you can see what the results of your merge will look like.

6.5 Previewing your copying



Whenever you use PowerPhotos to copy albums/photos or merge libraries, PowerPhotos will give
you a chance to see what the results will look like before actually copying any photos. This step will
be skipped if you have the “Show preview before merging” option disabled when doing a merge, or
the “Show preview before copying” option is disabled in the settings window if you’re copying
individual albums or photos. There will be four tabs at the top of the screen.

Report

This presenst a report giving an overview of how many photos and videos will be copied from each
library and how many duplicates (if any) will be skipped. This lets you see how the numbers add up
and how many new photos and videos will be added to the merged library. If some of the libraries
being merged have incomplete or missing items, the report will tell you how many of each are in
each source library.

Preview

This tab gives you the opportunity to preview what the destination library will look like before



actually proceeding to copy the photos over. You can browse the library preview just like you can do
with a normal library, including both grid view and list view, customizable subtitles and columns,
performing searches, and so on. By default, the name of the library each photo is being copied from
will be shown below the photo.

The preview will also show you what your albums will look like in the destination library after the
photos have been copied over, which lets you see the effects of several different settings. For
instance, when merging, if you have the “Combine contents of albums with same name” option
enabled, you can see how those albums will be combined.

Duplicates

If you are performing a merge or copying photos and have specified to skip copying duplicate
photos, this tab will let you see what duplicates PowerPhotos has found among the photos being
copied. In each group of duplicate photos, a checkmark will appear above the photo which has been
chosen to be included - the rest of the photos in the group will not be copied. If you wish to change
which duplicate is kept, select the photo and press the return key, and that photo will be given the
checkmark

Log

For each copying operation does, PowerPhotos create a log file

6.6 Handling duplicates when copying

Whenever you use PowerPhotos to copy photos or albums, or merge libraries, you can have
PowerPhotos attempt to detect duplicate photos in the photos being copied. This works much the
same way as when you use the Find Duplicates command, except that once the duplicate analysis
has been done, instead of taking specific actions on the duplicate photos (e.g. deleting or adding to
an album) one photo from each group of duplicates is chosen to be the one that is copied, and the
rest of the duplicate photos will be skipped.

When looking at the preview of the photo copying you’re about to do, you can click the “View
Duplicates” button in the upper right to see what duplicates were found among the photos being
copied. In each group of duplicate photos, a white checkmark will be displayed over the photo which
will be included when copied, and the rest of the photos in the group will not be copied. If any of the
photos which are not being copied belong to any albums which are being copied, the checked photo
will be added to that album in place of the other photo. If you wish to change which photo is used
for a particular group, either control-click the photo and choose “Use This Photo” from the menu
that comes up, or select the photo and press the return key.

Note that regardless of the duplicate criteria you specify, if one of the duplicate photos is located in
the library that you are copying to, that photo will always be chosen over new photos that are being
copied into the library. The reason for this is because, in order to use one of the other duplicate
photos instead, the duplicate already in the library would need to be deleted from the library, then

file:///Users/bwebster/Projects/UberProject/PowerPhotos/Docs/chapters/_temp_pdf_export.html#reports%23logs


the new photo would need to be added to all the places in the destination library (e.g. the albums
the photo belongs to, and any slideshows, books, etc.) where the original photo was. Unfortunately
this is not possible due to technical limitations with Photos, so we just keep the existing photo in
preference to any photo being newly copied into the library.

6.7 Copying limitations

Due to various technical limitations on what’s possible with the Photos app, there are some types of
items and pieces of information that cannot be copied between libraries by PowerPhotos. Below is a
summary of what can and cannot be copied, and some caveats that apply to certain types of items.

Fully supported: photos and videos, keeping keywords, descriptions, titles, dates, favorites,
locations, reversible photo edits, bursts, and Live Photos intact; albums and folders.

Partially supported: smart albums

Not supported: faces, projects (e.g. books, calendars, slideshows), and auto-generated collections
(e.g. memories, trips)

Photos and videos with basic metadata: Photos and videos can both be copied from one library to
another. In addition, PowerPhotos will also copy each photo’s keywords, description, title, date, and
favorite status over to the new library. Photos that are marked as hidden will not be copied, except if
you specifically copy them from the special “Hidden” album.

Albums and folders: Both albums and folders will be copied between libraries, and populated with
the same photos that they contained in the original library. When copying to the system library,
albums that have their photos manually ordered

Smart albums: A smart album cannot be recreated with its rules intact when copying between
libraries. If you copy a smart album, all of the photos in that smart album will be copied to the
destination library, and a regular album will be created and populated with those photos.

Original and edited versions of photos/videos: When you edit a photo in Photos, it actually keeps
around two copies of the photo: the unedited original, and a new JPG version that contains your
edits. This allows you to later discard your edits and revert to the original version of the photo if you
wish. PowerPhotos can copy both the original and edited versions of each photo, keeping reversible
edits intact in the destination library, as well as RAW+JPG pairs. Edits made to videos will be
preserved as well. If you wish, you can choose to copy only the original or the edited version of each
photo/video in the settings window, rather than keeping both. macOS 15.2 has a particular limitation
that requires appending “PWP_0000” to some photo filenames in order to retain edits. macOS 15.3
does not have this problem, so it’s recommended that you update to 15.3 to avoid this limitation.

Bursts: If you have used burst mode on your iPhone to take a series of photos that is shown by
Photos as a single burst, PowerPhotos can copy all the photos in the burst to another library. The
Photos app will let you select your favorite photo from a burst to display separately from the burst.
PowerPhotos will keep that photo separated in the copying process as well. Optionally, you can use
the PowerPhotos settings to only copy a single photo from each burst rather than copying every



photo.

Live Photos: PowerPhotos supports copying Live Photos, preserving both the photo and the
attached video that comes with it. This can be disabled in the settings if you only want to copy the
photo without the video.

Locations: Geographic locations can be assigned to your photos in two ways: either automatically
by your camera/phone when you take the photo (embedded in the photo’s EXIF data), or manually,
by assigning a location to photos using the Info window in Photos. PowerPhotos will preserve these
locations in either case when copying photos between libraries.

Faces: Photos does not support assigning face names programatically, so any faces identification
that has been performed will not be preserved when copying between libraries with PowerPhotos.

Projects: Photos projects such as books, calendars, and slideshows cannot be copied between
libraries.

6.8 Incomplete/Missing Items

Each photo or video you take or import into your library can actually have multiple pieces of data
associated with it in addition to the original photo/video. Some examples include:

Edited photos: When you edit a photo, Photos leaves the original photo unmodified, but
internally stores both a list of the edits you’ve performed, along with a separate edited version
of the photo.

Live Photos: When you take a Live Photo, there is a separate video that’s stored along with the
photo.

RAW+JPEG: Photos taken with a digital camera can have a separate RAW and JPEG version of
each photo shown as a single item.

Usually Photos keeps track of all this behind the scenes and you don’t have to worry about it, but
there are some cases where you can end up with an incomplete item, where one or more of these
pieces is missing from the library on disk, or a missing item, where there are no pieces at all
available on disk.

When can incomplete items occur?

The most common example happens if you have your library syncing with iCloud Photos and are
using the “Optimize Mac Storage” option. With this setup, Photos will only download a small
thumbnail used while browsing. Photos will only download the full size original when it needs to, e.g.
when you go to view or edit an individual photo.

Normally this is fine, because Photos will handle downloading photos and other pieces of data as
needed behind the scenes. However, if you make a copy of your Photos library (e.g. by copying
using the Finder, using the Duplicate Library command in PowerPhotos, or making a backup with
Time Machine or other backup software) that copy of the library will not have its own copies of the
full size original photos. Since that copy of the library is not syncing with iCloud Photos, those
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originals cannot be downloaded on demand, meaning that the library may have quite a number of
incomplete items.

Another somewhat common example is if you have imported some of your photos as referenced
photos, but then the original photos that are stored outside the library are deleted, moved, or
otherwise inacessible, then those photos will be incomplete because their originals cannot be found.

The last common example is iPhoto/Photos bugs or disk corruption that have caused some of the
pieces of a photo to go missing. It’s not uncommon for some edited photos in a migrated
iPhoto/Aperture library to have the original photo intact, but be missing the edited version of the
photo.

How does PowerPhotos handle incomplete items?

There are two main areas where PowerPhotos needs to do special handling for incomplete items.

1. Merging/copying. When you setup a merge, you can choose for PowerPhotos to either
completely skip copying any items that are incomplete, or have it do a partial import, i.e. make
a best attempt to import all the pieces that it does have, even if the result doesn’t match what
was originally there in the library before pieces went missing. For example, if the original for a
given photo is missing but the edited version is still in the library, then PowerPhotos will copy
the edited version of the photo alone. If you choose to skip incomplete items, then those items
will not appear in the merge preview, and errors will be logged to the PowerPhotos log file
indicating which items were incomplete. When copying photos or albums by drag and drop,
there is a similar setting in the PowerPhotos settings window that lets you choose how
incomplete items should be handled.

2. Find duplicates. When performing a duplicate search, incomplete items will still be included in
the search, but when it comes time to choose keepers, PowerPhotos will always prefer to keep a
complete item over an incomplete one in the same group of duplicates.

Partial import details

Here is how PowerPhotos handles some common scenarios if you’ve selected the option to fall back
to a partial import for incomplete items:

Missing original photos: if an edited version of the photo is still in the library, that photo will be
imported by itself in place of the original photo.

Missing edited photos: if the original is intact but the edited version of the photo is missing,
then the original will be copied by itself, i.e. the photo edits will be lost.

Missing videos in Live Photos: if the video component of a Live Photo is missing, then the
photo will be treated as a normal still photo with no paired video.

Unsupported edits: sometimes a photo will have been edited by an old version of
iPhoto/Aperture or a third party app where the lossless edits that have been performed can no
longer be reapplied to the photo. In these cases, PowerPhotos will import the original and edited
version of the photo as a single item, so you can still use the “Revert to Original” command in
Photos, but you won’t be able to adjust individual editing sliders and controls.

https://support.apple.com/guide/photos/change-where-photos-and-videos-are-stored-pht1ed9b966d/mac


Missing items

Lastly, there can be cases where a photo/video in the library is completely missing on disk and there
are no pieces that can even be used for a partial import. PowerPhotos detects these before the
merge or duplicate search starts and will simply skip over them, logging errors saying which
photos/videos were missing.

Is there any way to “fix” incomplete items?

The short answer is no - your library has whatever photos/videos it has, and there isn’t a simple way
to make the existing library whole again (with one exception, below). The best way to get as much
as you can out of the library is by using PowerPhotos to merge it into another library (you can even
merge into a new empty library if you don’t want to alter your existing library).

In the case where the library with incomplete items was a backup of an optimized iCloud library,
then in some cases you can designate that library as your new system library, reenable iCloud
Photos, and let Photos sync the backed up library with what’s currently in iCloud. However, it’s only
recommended to do this as long as:

1. You’re sure that this library was previously synced with iCloud Photos. If it wasn’t, then the
content of the library will be combined with whatever you currently have in iCloud, which may
result in duplicates or other photos you don’t want to have in iCloud.

2. You haven’t deleted a lot of photos/videos from iCloud since the backup of the library was
made. If items have been deleted from iCloud since the backup of the library was last synced,
then those same items will also be deleted from the local library when the sync occurs, which
could result in losing some items you were looking to recover (e.g. you had accidentally deleted
photos from iCloud and were trying to recover them from your backup).

Preventing incomplete items

The best way to prevent having to deal with incomplete items in the first place is to follow the advice
given in the “Backing up your Photos Libraries” page of the PowerPhotos manual.

6.9 Copying and merging with iCloud Photos

There are a few additional things you should consider if you’re copying or merging photos into the
library you have syncing with iCloud Photos. If iCloud Photos is enabled when you do this, it will
immediately start uploading any new photos that you copy into your library up to iCloud. This may
not be desirable if you’re copying a large number of photos, especially if you want to double check
your copy/merge results before committing to uploading the results to iCloud. Here are a couple
techniques worth considering.

1. Temporarily turn off iCloud syncing. You can do this by following the directions under “Pause
library uploads to iCloud” in this Apple support article. Your current collection of photos will

https://support.apple.com/en-us/HT204264


remain in iCloud, but your Mac will stop actively syncing new content while this checkbox is off.
You can then performing your copying/merging and double check the results to make sure
they’re to your liking. If they are, then go back and unpause syncing, and Photos will upload
your newly copied photos to iCloud. Note that it will take some time for it to compare the library
content to iCloud again, but it shouldn’t need to re-upload any of the photos that were already
in the library.

2. Work on a copy of the library instead. Instead of merging directly into the library you have
synced with iCloud, create a copy of the library first, either using the Finder or the “Duplicate
Library” command in PowerPhotos. This requires having some extra free space, but has the
advantage that you can keep your iCloud library syncing while you do your copying/merging
with the other copy of the library. If you change your mind or decide you want to redo the merge
with different settings, simply delete that copy of your library, and the original library remains
unchanged. If you’re happy with the results of the merge, then use the Photos settings window
to first make that library the system photo library, then enable iCloud Photos to have it sync up
the new photos with iCloud.

One approach you should be cautious with is merging multiple libraries, including your iCloud library,
into a new, empty library. The downside to this is that none of the iCloud-specific syncing
information associated with your photos will be copied into the new library. After finishing the
merge, if you decide to enable iCloud Photos on the new merged library, Photos may have trouble
matching up the photos in the merged library with the corresponding copies that are already in
iCloud, resulting in duplicates of some or many of your photos. If you’re performing a merge that
includes your iCloud library, it’s recommended that you use one of the two techniques above, as
both of those methods will preserve the iCloud syncing information.

6.10 Reports

Whenever you use PowerPhotos to copy albums or photos, import photos, merge libraries, or find
duplicate photos, PowerPhotos will create a persistent report that contains details about what
happened during the operation. You can view your reports by clicking the Reports button in the
toolbar, or choosing View > Sidebar > Show Reports from the menu bar. Your list of reports will be
displayed in the sidebar, replacing the library list. You can click the Libraries button in the toolbar or
choose View > Sidebar > Show Libraries to switch back to viewing your libraries in the sidebar.



Once you select a report in the sidebar, it will show you the details of what happened during that
operation. Note that reports will be included even for operations you didn’t run to completion, e.g. a
merge that got to the preview stage but then was cancelled, or a duplicate search where no
duplicate photos were deleted.

The report can show different columns depending on the type of operation:

Copying photos/albums, importing, or merging libraries

Total items: shows the total number of items in each library before the operation started.

Items copied: shows the total number if items that were going to be copied to the destination
library. This number excludes any items that will be skipped by PowerPhotos, either because
they are duplicates or are missing/incomplete.

Incomplete items (skipped): if the setting for handling incomplete items was set to “Skip”,
then this will indicate the number of incomplete items that were skipped

Partial copies: if the setting for handling incomplete items was set to “Copy whatever version is
available”, this will indicate how many such partial copies were performed.

Failed to Copy: if there are any photos or videos that fail to copy (e.g. because Photos returns
an error upon trying to import them), this will list how many items failed to copy.

Missing items: shows the number of missing items detected in the library.

Duplicates skipped: if duplicate detection was enabled, shows the number of duplicate photos
from the library that were skipped and not copied to the destination library.

Some columns will show differently when viewing an operation that was run until the preview stage,



but cancelled before performing the actual copying. For example, instead of “Items copied” the
same column will be labelled “Items to copy”, and so forth.

Find Duplicates

Total items: shows the total number of items in each library before the operation started.

Duplicates found: shows the total number of duplicate photos found in the library.

Marked keepers: shows the total number of duplicate photos marked as keepers, which are not
deleted from the library.

Moved to trash: shows the total number of duplicate photos/videos moved to the trash.

Could not analyze: shows the total number of photos/videos that could not be analyzed
because of an error, e.g retrieving image data.

If the duplicate search was run, but you opted not to trash any items, the last column will be labelled
“Marked to trash” instead of “Moved to trash”.

Export

Total items: shows the total number of items that were selected to be exported.

Items exported: shows the number of items that were successfully exported.

Failed to export: shows the number of items that were not exported because of an error.

Missing items: shows the number of items that were not exported because they were missing
from the library.

Inspecting and taking action on groups of photos

Seeing what happened during a big merge is a good start, but PowerPhotos will also let you inspect
and take action on some groups of photos. Some counts listed in the report will have a little
magnifying glass

icon next to them which you can click to view all the photos in that group. For example, if you had a
number of photos that failed to copy during a merge, you can click to browse through the failed
items and see if there might be something they have in common that might explain the failures.

You can do the following things with the photos you see in the report:

Export: select any photos you want and click “Export” to try to export a copy of the photos to a
regular folder on your hard drive.

Delete: select any photos you wish to delete and click the “Delete” button to delete them from
the library.

Create Album: select any or all the photos and click the “Create Album” button to create a new
album in that library.



Some examples of useful things to do:

If there is a batch of photos that either failed to copy, or shows up as missing/incomplete, you
can use the “Create Album” command to collect them into an album in Photos so you can take a
closer look at them to see if they can even be viewed, or if they have anything in common that
might explain the problem.

If a batch of photos failed to copy for some reason, you might try exporting a copy of the photos
to see if that’s possible where a direct copy failed.

If you’ve successfully copied a batch of photos to another library, you can view those photos
and delete them from the original library if you don’t want copies there any more.

Also note that because a given library may have changed or been removed entirely since the
operation in the report took place, you may not always be able to inspect all the photos that were in
the library before. When this is the case, PowerPhotos will display a message at the top of the
window saying “N photos are no longer present in the library X and are not displayed below.” If the
library itself has been removed from PowerPhotos since the operation took place, then you’ll receive
an error message when clicking the magnifying glass button.

Logs

PowerPhotos also generates a plain text log file for each major operation it performs. When viewing
a report, you can click the “View Log” button in the upper right to see the contents of the log file.
The log is more of a large information dump of everything that happens during the operation, and
can sometimes contain further details not shown in the overview of the report. You can see all the
logs generated by PowerPhotos by selecting the Window > Show Logs menu item.

If your Logs or Reports folder grows to larger than 200 MB, PowerPhotos automatically deletes logs
and reports older than 30 days to ensure they don’t accumulate over time and take up too much
disk space.



7. Exporting photos from a library

In addition to copying photos between libraries, PowerPhotos also lets you export copies of your
photos from a library to a folder on your hard drive.

7.1 Starting an export

PowerPhotos provides three different ways to choose a set of photos to export from a library.

Individual photos: You can select one or many photos in the photo browser to export.
Exporting this way will not recreate any subfolders based on your library’s albums, it will only
export the selected photos to a single, flat folder.

Albums: You can select one or more albums or folders in the album list to export as well. When
exporting this way, you’ll have the option to create nested subfolders that mirror the albums and
folders in your Photos library.

Whole library: You can select a library in the library list and choose to export the entire library
at once. This will export every photo and video in the library, and give you the option to also
recreate the library’s album hierarchy, the same way as when exporting individual albums.

To start an export, select the photos, albums, or library you want to export, then select “Export”
from the File menu. You can also right-click on these items and choose “Export” from the contextual
menu.

PowerPhotos will then display a number of options for your export, including export types, format
and size settings, metadata options, video settings, file organization, and additional files. After
you’ve configured the export, click the “Export” button in the upper right to perform the export.



7.2 Available export types

When exporting, you can choose from three different export types:

Unmodified original: Exports the unedited photo that was originally imported into the library. When
exporting unmodified originals, none of the other options to modify the exported photos will be
available. For RAW+JPEG photos (photos that were imported as both RAW and JPEG), both the RAW
and JPEG files will be exported.

Original with metadata: Exports the original photo with any metadata you’ve added in Photos (such
as keywords, titles, captions, etc.) embedded in the photo. This allows you to preserve your
metadata while keeping the original pixel data intact. Unlike “Edited” mode, PowerPhotos preserves
the original pixel data without any recompression, only updating the file’s embedded metadata.

Note: Only certain formats support embedded metadata (JPEG, HEIC, PNG, TIFF, MOV, and MP4).
For other formats, PowerPhotos will export the unmodified original even when “Original with
metadata” is selected.

For RAW photos, since RAW files cannot have their embedded metadata modified, PowerPhotos
provides two options:

Export with metadata: Converts the RAW file to your chosen format (JPEG, HEIC, PNG, or
TIFF) and applies both your edits and updated metadata. Click the gear icon next to this option
to configure the format, quality, and size settings that will be used when converting the RAW
file.



Unmodified RAW: Exports the RAW file exactly as-is, without any metadata changes or format
conversion. You can use XMP sidecar files to preserve your metadata alongside the RAW file.

Edited: Exports the current version of the photo, including any edits that have been made in Photos.

Note that animated GIFs will always be exported as original since converting them to a format that
only shows a single still photo doesn’t make sense.

7.3 Choosing format and size

When format and size options are available

The format, quality, and size options described below are only available when exporting in “Edited”
mode. When using “Unmodified original” or “Original with metadata” modes, these settings are
disabled in the main export panel since the original file format and size are preserved.

Exception: When using “Original with metadata” mode with RAW photos and choosing to export with
metadata, you can click the gear icon next to the RAW export option to configure format, quality,
and size settings specifically for the RAW conversion.

Format & quality

PowerPhotos supports exporting photos as JPG, HEIF, PNG, or TIFF. You can also choose “Match
Original” to have PowerPhotos export each photo in its original format. For example, photos
originally imported as JPG will be exported as JPG, HEIC photos as HEIC, etc. When using “Match
Original”, you can specify a fallback format to use for photos that are in a format not supported by
the other options (such as RAW files). The fallback can convert these photos to JPG, HEIF, PNG, or
TIFF, or you can choose to export the unmodified original instead.

The JPG and HEIF formats use lossy compression, and allow you to select what quality of
compression you’d like to use. Higher quality will make the photo look better, but result in a larger
file size, whereas lower quality will take less disk space, but the photo may lose some of its finer
details.

Size

By default each photo will be exported at its current pixel size, but you can also tell PowerPhotos to
scale down the photos to a custom size. Enter a number of pixels to scale to, then choose to have
PowerPhotos scale the photo to either have its height or width match that pixel count. Choosing the
“Dimension” option will tell PowerPhotos to scale whichever side of each photo is largest to that
pixel count. PowerPhotos will never scale an image to be larger than its current size. If a photo is
already smaller than the size you specify, it will be exported without being resized.

7.4 Additional files

Live Photo videos

When exporting Live Photos, PowerPhotos can export both the photo and video components of each



Live Photo. If selected, a .mov file will be exported alongside the photo with the same filename as
the photo (e.g. exporting “IMG_1234.JPG” will also export a “IMG_1234.MOV” file). If you later
import the photo/video pair back into a Photos library, Photos will recombine the two parts to show
them as an individual Live Photo. Only JPG and HEIC support Live Photos though, so videos will not
be included when exporting as PNG or TIFF.

Burst photos

If you have burst photo sequences in your library, PowerPhotos can optionally include all photos in
the burst sequence when exporting, not just the photos you’ve selected from the burst. This option
is available for all export types.

XMP sidecars

PowerPhotos can optionally export XMP sidecar files alongside your photos. XMP sidecars are XML
files that contain metadata about the photo (such as keywords, titles, captions, dates, and
locations), and are especially useful when exporting RAW files with “Original with metadata” mode
where you’ve chosen to export the unmodified RAW.

Since RAW files cannot have their embedded metadata modified, the XMP sidecar provides a way to
preserve your metadata in a separate file that travels alongside the photo. Many photo management
and editing applications can read XMP sidecar files and use them to display your metadata even
when the metadata isn’t embedded in the photo file itself.

You can choose to export XMP sidecars for RAW files only, or for all photos.

7.5 Supported metadata

Metadata and export types

Metadata options are available when using the “Original with metadata” or “Edited” export types.
When using “Unmodified original”, metadata options are disabled and files are exported exactly as
they were originally imported, without any metadata modifications.

Supported metadata types

PowerPhotos can include metadata that you’ve assigned to your photos and videos embedded in the
EXIF metadata of each exported file. This includes dates, keywords, titles, captions, and GPS
locations. If any of these options is unchecked, PowerPhotos will not add the metadata to the
exported file’s EXIF data, but if the original file had any of this metadata, it may still be present in the
exported file. The exception to this is location data, which can be privacy concern. If the Location
box is unchecked, then PowerPhotos will make sure to strip all location data from the exported file.

These metadata options apply to both photos and videos.

7.6 Video options

PowerPhotos can export videos as well as photos. When exporting videos, you can choose a size



and type of compression to use, similar to the quality settings for photos. The default choice is
exporting as H.264 video at 720p. You can choose a different size, or you can also choose to export
using the newer HEVC codec, which results in smaller file sizes, but may not be playable on older
devices.

Video export types

Video exports support three export types:

Unmodified original: Exports the original video file without any changes

Original with metadata: Preserves the original video encoding while applying your metadata
changes (keywords, dates, titles, captions, locations)

Edited: Exports the video with any edits and applies your chosen quality settings and metadata

7.7 Files and folders

Subfolders

If you are exporting albums, PowerPhotos can organize the exported photos into subfolders in
several ways:

None: All photos will be exported into a single flat folder

Album hierarchy: Photos will be organized into folders that mirror the album hierarchy in your
library. You can choose whether to include smart albums in the folder hierarchy. This option is
only available if you have selected one or more albums to export, and will not be listed if you
have selected photos to export instead of albums.

Library folder + album hierarchy: This option is only available if you have selected to export an
entire library. PowerPhotos will create two subfolders. The first, named “Library”, will contain all
the photos/videos from the library exported in one flat folder. The second, named “Albums”, will
contain the hierarchy of albums that you have created in the library in Photos. The files created
in the Albums folder and its subfolders will link to the copies exported to the Library folder as
described below.

When using album-based organization, PowerPhotos can handle photos that appear in multiple
albums in several ways:

Separate copies: Each photo will be exported once for each album it appears in, resulting in
multiple copies of the same photo.

Hard links: Photos that appear in multiple albums will be linked together using hard links, so
they take up only one copy’s worth of disk space. With hard link, the two copies of the file share
the underlying data, so modifications made to one will appear if you view the other. Either file
can be deleted without affecting the other.

Symbolic links: Photos that appear in multiple albums will be linked together using symbolic
links. Here, the link refers to the other file by path, so if you delete or move the original photo, it
will break any symlinks that were pointing to it.

File clones: On APFS volumes, photos that appear in multiple albums will be linked together



using file clones, which are copy-on-write duplicates that initially take up no additional disk
space. This is functionally equivalent to making two independent copies of the file, so unlike
with hard links, modifications made to one file will not appear when viewing the other file.

File naming

You can choose what filenames PowerPhotos uses for the exported photos:

Filename: Uses the original filename of the photo when it was first imported into the library.

Title: If you have given custom titles to your photos, PowerPhotos will use that title as the
filename. For photos without a title, PowerPhotos will fall back to using the filename instead.

Sequential: PowerPhotos will name each photo with the same prefix, and an incrementing
number appended to the end. For example, if you specify the prefix “image_”, then the exported
files will be named “image_001.jpg”, “image_002.jpg”, and so forth.

If the file naming option you choose results in more than one photo having the same filename (e.g. if
the “Filename” option is selected, and you export two different photos named “IMG_0001.JPG” to
the same folder), then PowerPhotos will automatically append a number to the end of the additional
copies of the photo to avoid filename collisions (e.g. “IMG_0001 2.JPG”)

File creation/modification date

By default, the files created by PowerPhotos will have a creation date shown in the Finder of when
the export was performed. If you select the “Photo date” option instead, then PowerPhotos will
assign the date the photo was taken (including any adjustments you’ve made to the photo’s date
using Photos) as the file’s creation date instead. A similar setting is provided for setting the Finder
modification date as well.

When file already exists

When exporting to an existing folder, if there are files already present in that folder, then it’s possible
that PowerPhotos will need to export a file to a location where a file already exists. In this case, you
have three options:

Replace existing file: the existing file will be overwritten by the newly exported one

Keep existing file: PowerPhotos will skip exporting the photo, and keep the existing file in place
instead

Rename exported file: PowerPhotos will choose a new name for the exported file by appending
a number to the end of the filename, so that both the existing file and exported file will be in the
folder side by side

7.8 Export presets

PowerPhotos allows you to save a particular set of export settings as a preset, allowing you to easily
reuse your favorite export setups. PowerPhotos ships with a handful of common presets to get your
started, which are accessible from the “Export Presets” menu in the upper right. You can use the
menu to switch presets, save your current settings as a new preset, and access your full list of
presets to rearrange and delete presets in your preset list.



If you want to use PowerPhotos export action in Shortcuts, that exclusively uses presets to specify
export settings, so you’ll want to set up a preset in PowerPhotos first so you can use it in your
Shortcuts action.

7.9 Exporting from iCloud Photos

When exporting photos from a library syncing with iCloud Photos, PowerPhotos will automatically
ask Photos to download the full resolution photo if necessary so that it can export based on the
highest quality image available. However, do note that if you have the “Optimize Mac Storage”
option enabled, then performing an export and forcing a whole bunch of downloads will make your
library consume more disk space, potentially filling up the drive if you are exporting a large number
of photos. If you want to do an export of your entire library and don’t have enough storage space on
your internal drive, then you might consider moving your iCloud library to an external drive first, then
performing the export from there.

file:///Users/bwebster/Projects/UberProject/PowerPhotos/Docs/chapters/_temp_pdf_export.html#shortcut_export_photos


8. Converting iPhoto and Aperture libraries

If you used iPhoto or Aperture before transitioning to Apple’s newer Photos app, up until macOS
12.0 Monterey, Photos has had the ability to migrate your old iPhoto/Aperture library to a Photos
library. However, starting in macOS 13 Ventura, Apple no longer supports its migration process,
leaving importing the iPhoto library into an existing Photos library as the only option. This is far from
ideal, because unlike migration, importing does not retain your album organization, photo edits, or
photo metadata in the process.

If you want to preserve all that information from your iPhoto or Aperture library, you can instead use
PowerPhotos to convert your old library to an equivalent Photos library. To start, choose the File >
Convert iPhoto/Aperture libraries menu item. PowerPhotos will search your Mac for any
iPhoto/Aperture libraries it can find, and allow you to add them to the PowerPhotos library list. You
can also just drag an iPhoto/Aperture library directly from the Finder and drop it into the library list.

Once the library is in the PowerPhotos library list, you can view it alongside all your Photos libraries,
so you can see how many photos it has, what albums it contains, and even view or search the photo
metadata, just like with your Photos libraries. You cannot use any functions that modify the iPhoto
library, such as deleting duplicates, creating albums, and so forth, but in all other respects you can
do all the same things you can with a Photos library.

If you simply want to convert the library to Photos, select the library and click the “Convert…” button
in the upper right. This will create a new Photos library and copy the entire contents of the
iPhoto/Aperture library into the new library. You can also set up a merge to merge the
iPhoto/Aperture library directly into an existing Photos library, or copy individual albums or photos
by drag and drop.

PowerPhotos conversion process does differ from the old Photos migration in a few ways.

|Photos Migration|PowerPhotos Conversion |—| |Preserves albums, folders, and smart
albums|Preserves folders and albums, converts smart albums into regular albums| |Preserves photo
titles, captions, keywords, dates, locations, and faces|Preserves all the same metadata except for
faces| |Converts star ratings and flags into keywords|Same| |Preserves photo edits, but not lossless
editing|Same| |Books are converted to albums|Doesn’t preserve books| |Preserves
slideshows|Doesn’t preserve slideshows| |Always creates new library alongside original|Choose any
folder to create the new library, or merge/copy directly into an existing library| |Always migrates the
entire library|Allows copying individual photos/albums out of the library as well| |Saves space by
linking photos from the old library|Makes new copies of the photos, requiring additional disk space|
|Works only on macOS Monterey and earlier|Works on macOS Monterey and later| |Does not support
libraries before iPhoto 8|Supports iPhoto 2 or later and Aperture 3.3 or later|

Converting from Aperture

Because PowerPhotos’ conversion process is based on its predecessor, iPhoto Library Manager,
there are some aspects of Aperture libraries that will not be preserved when converting an Aperture
library. The primary things of note are as follows.

Projects: iPhoto had the concept of “events”, which divided up photos into groups based on the
date they were taken, and could be later customized and rearranged by the user. Photos does not

https://web.archive.org/web/20200315041706/https://support.apple.com/en-us/HT204655
https://support.apple.com/en-us/HT209528


have a similar concept, so iPhoto events are converted into albums in the resulting Photos library,
and will be stored inside a folder named “iPhoto Events”.

Aperture had a similar structure it called “projects” (not to be confused with iPhoto/Photos projects,
e.g. books, calendars, etc.), which worked much the same way. The main difference was that iPhoto
events were stored as a single flat list, whereas Aperture projects could be organized into a
hierarchy. PowerPhotos does not support restoring the project hierarchy, and will instead recreate
the projects as a flat list in the “iPhoto Events” folder.

Keywords: Aperture supported organizing its keywords into a hierarchy as well, but Photos keeps
its keywords as a flat list, so keywords coming from an Aperture library will lose their hierarchical
arrangements.

Labels: Aperture supported assigning color labels to photos. These are not converted by
PowerPhotos

Stacks: Photos that have been grouped into “stacks” in Aperture will appear as individual items in
the resulting Photos library.

Previews: Aperture had a setting labelled “Generate Previews” which controlled whether it would
create and store a rendered JPG inside the library for any photo that had been edited. This was
enabled by default, but could be disabled if you wanted to save disk space by not storing a separate
JPG for every photo you had edited, and instead taking a small speed hit when viewing an edited
photo while Aperture had to reapply its edits to show the photo. If you’re using PowerPhotos to
convert an Aperture library that had this setting disabled, then it will not be able to retain the edits
for any photo that was edited, and you’ll end up with just the original, unmodified photo in the
resulting Photos library.

Vaults: Aperture vaults (which end in a .apvault file extension instead of .aplibrary) are not
supported by PowerPhotos.



9. Frequently asked questions

9.1 Restoring photos from Time Machine

If you have a Photos library that has either become corrupt or had photos accidentally deleted from
it, and you have been using Time Machine to back up your library, you can restore a copy of your
older library to access those photos again. You can restore your library by following the instructions
on Apple’s Restore items backed up by Time Machine support page. Once the library has been
restored, add the library to PowerPhotos’ library list. The library will need to be opened once in
Photos to allow it to complete the restoration process before PowerPhotos will be able to display the
library’s content in its own window.

9.2 How long should a merge take? How can I
speed up my merge?

Merging libraries (or doing large album/photo copies) can be a very intensive operation, involving a
lot of processing and data copying, and thus can take quite a while to complete. There are many
factors that can affect how long a merge takes, so it’s very difficult to accurately predict how long a
given merge can take, but here are some factors that may affect your merge time and a few ways to
try to speed things up.

How long should a merge take?

A “typical” merge involving maybe tens of thousands photos can easily take a few hours to
complete. If you have lots of libraries, possibly involving 100,000 photos or more, then a merg can
potentially take multiple days in extreme cases. The primary factors that affect how long a merge
takes are as follows, with the most relevant first, decreasing in importance as you go down the list.

1. Number and size of photos/videos The primary factor is the size of the libraries being merged,
both in terms of the total number of items, and the total size (e.g. in megabytes/gigabytes) of
the libraries involved. If you have any easy pruning of photos/videos from any of your libraries
that you can do before starting the merge, that can help. Photos/videos that are in the “Recently
Deleted” album during a merge are ignored and won’t affect the merge completion time.

2. The number of duplicates If your libraries have a large number of duplicate photos among
them, then that will make the merge take longer, because of the additional checking that
PowerPhotos has to do to find all the groups of duplicates and ensure only one copy from each
group ends up in the merged library.

3. The speed of the drive(s) containing the libraries Merging involves a lot of file reading and
copying, so the slower the drives that contain the libraries you’re merging, the longer the merge



will take. Generally speaking SSDs are the faster, followed by “spinning platter” hard drives, and
finally drives accessed over a network, either using file sharing or a NAS.

4. Using an optimized iCloud library as one of source libraries If you’re merging photos from
your iCloud library into another library, and have the “Optimize Mac Storage” option enabled for
iCloud Photos, then Photos will need to download all the photos/videos from iCloud during the
merge process so that they can be copied over to the merge destination. Using your iCloud
library as the destination does not have this same problem.

5. The speed of your Mac’s processor This is much less of a factor than the ones listed above,
but the duplicate analysis phase of the merge does involve a lot of computation, so older Macs
will tend to be slower analyzing duplicates.

One factor that doesn’t affect merge speed very much is the amount of RAM in your Mac. The
merge process is mostly limited by data transfer, and doesn’t use large amounts of RAM, so other
than having some other app on your system using lots of RAM while the merge is taking place,
system memory shouldn’t be a big factor. But quitting Slack couldn’t hurt.

How can I speed up my merge?

All that being said, here are a few tips you can use to try to speed up your merge.

1. Merge into an existing library When you setup a merge, you have the choice to either merge
your libraries into a brand new empty library, or use one of your existing libraries as the
destination and copy the photos from all your other libraries into the existing library. Choosing
an existing library as the destination means that no photos from that library need to be copied,
which can help decrease the total amount of data that needs to be copied during the merge
process, and thus speed up the merge. All else being equal, using your largest library as the
destination should give you the most speed benefit.

2. Put your libraries on fast drives If possible, putting your libraries on the fastest available
drives can speed up the merge process significantly. This can be difficult since often your
fastest drive is your internal SSD, which is also the drive most likely to run out of space. At the
very least, try to avoid using network drives during the merge process itself, since they are the
slowest. For example, if you ultimately want your merged library to be stored on a NAS, you
might want to first do the merge on a locally attached hard drive, and then copy the merged
library to the NAS once the merge is complete.

3. Put libraries on the same APFS drive Apple’s new(er) APFS drive format has a feature called
“file cloning” which PowerPhotos can take advantage of when merging. If both the source and
destination library are on the same APFS drive, then photos and videos can often be transferred
to the merged library without having to make a separate physical copy of the data on disk,
which can greatly speed up the process.

4. Disable duplicate detection if you don’t need it One of the great benefits of merging with
PowerPhotos is that it can eliminate duplicate photos during the merge process, ensuring that
only one copy of each photo ends up in the merged library. However, if you’re confident that the
libraries you’re merging don’t overlap and would not contain any duplicates, then unchecking
the “Eliminate duplicates while merging” checkbox can save a lot of time for the merge process.

5. You don’t need to merge all your libraries at the same time If you have a lot of libraries that



you want to merge together, the obvious way to proceed is to simply add all the libraries to the
merge setup at once and let PowerPhotos crunch its way through everything. This will work, but
if the total number of photos is extremely large, it can take a very long time to get through a
giant merge like this. One alternative is to do the merge in smaller batches, by only merging one
or a few libraries at a time into your merged library. Doing the merge bit by bit will have the
same result as doing it all at once, and while the total time from beginning to end may actually
be a bit longer, splitting it up into several smaller merges means each individual merge doesn’t
take nearly as long, and lets you check in after each step to make sure things are proceeding as
you expect.

9.3 Splitting a library into smaller libraries

If you have a library that has gotten too large and you want to split it into multiple, smaller libraries,
there are a couple different ways you can go about doing so.

Copying Albums/Photos

First, click the “+” button and select “New Library” to choose the location you want to create the
second library.

Then, drag one or more albums or photos from your big library onto your newly created library in
PowerPhotos. This will copy those albums/photos over to the new library, including all their
metadata and edits. After you have copied the photos to your new library, you can use Photos to
delete them from the big library to clear up the disk space in that library. You can repeat this
process with small or large batches of albums and any number of libraries to split up your collection
into smaller, more manageable pieces.

One common way of splitting up a library is to split things up by date, e.g. so you have one library
per year. The easiest way to do that is to create a smart album in your Photos library that uses the
“Date” field to show just photos from a certain range of dates. For example, if you wanted to make a
library with just photos from 2013, you’d set up a smart album with a date range from Jan 1, 2013 to
Dec 31, 2013. Then in PowerPhotos, you can just create a new library then drag that smart album
over to the new library to copy all those photos across. Then just repeat for each library you want to
create with a different date range.

Duplicate & Prune

Use the “Duplicate Library” command in the File menu to make a copy of the library folder that you
want to split. You can then open one copy of the library and move whatever photos and albums you
don’t want in that library to its trash. Then open the second library and move the rest of the photos
into that library’s trash. After double checking to make sure that no photos have been trashed from
both libraries, empty the trash of each library. This method is useful if you want to avoid some of the
copying limitations that are imposed on PowerPhotos by what Photos itself is capable of.

iCloud Photos and Optimize Storage If you are using iCloud Photos and have the “Optimize Mac
Storage” option enabled, then Photos will only download full size photos from iCloud as they are
needed, which means that your library will likely not have full size copies of its photos stored locally.
If you are using this setting, then it’s recommended you use the Copying Albums/Photos approach
instead of Duplicate & Prune, since the duplicate copy of the library won’t actually have all the



photos you want.

9.4 Creating a new library using photos not already
in Photos

In order for photos to show up in the Photos window, they must first be imported into the Photos
library. If you already have a folder full of photos you want to use with Photos, just pointing Photos
to the folder full of pictures won’t make it automatically recognize and be able to work with them. To
make a library with the folder full of pictures, you should first make a new library in PowerPhotos,
open that library, then drag the folder of photos from the Finder into Photos.

9.5 Undoing photo deletions

In some cases, you might end up deleting a number of photos to the trash in Photos (e.g. when
using the Find Duplicates command), but then decide you don’t want to delete the photos after all.
Fortunately, deleting photos is not immediately permanent, and there is a way to return recently
deleted photos to the main section of the library. To do so:

1. Open the library in the Photos app.

2. Among the library’s albums in the album list on the left, you should see one named “Recently
Deleted”. Select that album to view your recently deleted photos. Note that if you have not
deleted any photos in your library, the Recently Deleted album will not appear in the album list.

3. Click any photos that you would like to return to the library to select them.

4. Click the “Recover” button in the upper right corner of the window. This will “undelete” the
photos so they once again appear in the library. The photos will also be returned to any albums
they belonged to when they were deleted.

9.6 Sharing a library between multiple user
accounts on one Mac

Photos is not designed with multi-user use in mind, which makes it very difficult to create a setup
where a single Photos library can be accessed from multiple accounts on your Mac. If you wish to
share a library this way, the following restrictions will apply (for the below discussion, assume we
have two users named A and B that we want to share a library):

1. Only one user account can ever have a given library open in Photos at a time. Before you can
use the shared library as user A, you must first make sure to quit Photos as user B.



2. None of the user accounts that are accessing the library can designate it as their “system
library”. The system library is effectively open at all times by macOS in the background as long
as that user is logged in, so even quitting Photos will not free up the library so that another user
can open it. You must either designate a different library as the system library, or fully log out
user B before trying to access the library as user A. Note that this also precludes having this
library sync with iCloud Photos.

3. The library cannot be stored on your internal drive, or any other drive where permissions are
respected. Fighting against permissions on macOS is a losing battle; while you can play whack-
a-mole trying to fix permissions on the library before you open it, something will eventually go
awry and it’s likely you’ll be unable to access some portion of your library. You should store the
library on an external drive, and in the Get Info window in the Finder, make sure that the “Ignore
ownership on this volume” checkbox is checked.

9.7 Merging libraries from multiple Macs

If you have libraries from more than one Mac that you’d like to merge together, you will need to first
choose which Mac you want to run PowerPhotos on. You’ll need to set up that Mac so that it can
access all the libraries you want to merge together. You can do that one of the following ways:

1. File sharing across a network. This is the same way you would set up PowerPhotos to directly
access a library on another Mac or a network drive. You can find directions for setting this up at
Accessing a Photos library on another Mac.

2. Copying the library across the network. This starts the same as in option (1), but after you have
access to the second Mac’s library, you then use the File > Duplicate Library command in
PowerPhotos to make a copy of the library on your Mac’s local drive. This has the advantages
that you don’t need to keep the network connection open during the merge process itself, and
since everything will be getting copied locally, the merge process will take much less time.

3. Putting the library on an external drive. This requires having a Mac formatted external drive with
enough free space to hold the library you want to transfer. You would first plug the drive into the
second Mac, copy the library from there to the external drive, then plug the drive into the Mac
where you’ll be doing the merging.

After making each library accessible from the Mac you’re running PowerPhotos on, you can then
choose File > Add Existing Library to add each library to the PowerPhotos library list. Note that since
network and external drives are often not indexed by Spotlight, your library might not show up
automatically in the list that PowerPhotos presents when you bring up the Add Existing Library
window. If you don’t see your library there, click the “Choose Manually” button to choose that
library’s location manually.

Once all the libraries are present in the PowerPhotos library list, you can set up a new merge and
proceed from there.

9.8 How to merge an iPhoto library with a Photos

file:///Users/bwebster/Projects/UberProject/PowerPhotos/Docs/chapters/merge_libraries.md


library

If you have a mix of one or more iPhoto or Aperture libraries and Photos libraries that you would like
to merge together, you can directly merge the iPhoto/Aperture library into a Photos library just like
you can with any other Photos library.

When not to merge an iPhoto library with your Photos library

There is one common situation in which many users believe they need to perform a merge of an
iPhoto library and a Photos library, but is usually not necessary. If you have an iPhoto library that you
already migrated over to Photos, the iPhoto library will remain on the hard drive after performing the
migration. This will result in an iPhoto library and a Photos library appearing side by side in your
Pictures folder.

It can be easy to forget that this happened, come across the iPhoto library later on, think that it has
different content from the Photos library, and thus needs to be merged. However, since the Photos
library starts out with everything that was already in iPhoto before the migration, performing a
merge will usually just be a waste of time, since no new content will come in from the iPhoto library
that wasn’t already in the Photos library.

The only exception to this is if you migrated to Photos, but then continued using iPhoto for some
time after performing the initial migration. Only in this case, where you have added new content to
the iPhoto library after the migration, should a merge be necessary.

9.9 PowerPhotos duplicate detection compared to
built-in Photos duplicate detection

Starting in iOS 16 and macOS Ventura, Apple added a feature to their Photos app that can detect
and eliminate duplicate photos. The two function pretty similarly overall, but Photos’ system works
differently from PowerPhotos in a number of ways, both with their advantages.

Photos

Photos system works automatically in the background, and will display a “Duplicates” album
containing what it has found when it’s finished searching. It doesn’t give any progress information or
let you control how or when it searches though, and Photos’ duplicate detection only operates on a
single library at a time.

You can browse through the duplicates that it’s found and choose to merge one or more duplicate
pairs together, which will take various data from both copies of the photos such as metadata and
editing information and combine them into a single photo in the database. The exact way this works
isn’t documented by Apple and doesn’t offer much control, but does a good job of trying to retain as
much information as it can.



PowerPhotos

With PowerPhotos, you perform an explicit duplicate search, and can specify one or more libraries
to search through. PowerPhotos does a similar visual duplicate search to Photos, but offers
additional options that let you control whether other aspects of the photos need to match too,
including things like filenames, dates, and photo size.

PowerPhotos doesn’t merge photos info like Photos does, but instead gives you control over
choosing which photo to keep from each group of duplicates that it finds, either using its built-in
rule system for automatically choosing keepers based on a number of criteria, or by manually
selecting keepers yourself. In addition to simply deleting the extra duplicates, PowerPhotos will let
you collect the extra duplicates into an album instead if you’d like to review them further before
deleting them.

Which of the two will find more duplicates depends on the individual library - sometimes Photos will
find more, and sometimes PowerPhotos will find more. Feel free to use both of them on your library
to get rid of all the duplicates both of them can find. If you prefer Photos method of combining
photos then try running it first, then PowerPhotos, or if you need PowerPhotos greater control, you
can run it first instead.

9.10 What is the maximum/optimal size for a photo
library?

When deciding how to organize your photos among multiple libraries, one common thing to wonder
is what size you should make each of your libraries. There is no single answer to this question, but
here are some tips to guide you in making your decision.

The primary reason to keep a library from getting too large is performance. Larger libraries do tend
to be slower when used in Photos or PowerPhotos, so keeping your library from ballooning too large
can help keep day to day use responsive. The exact size will vary greatly depending on a number of
factors, including how old your Mac is, how much memory it has, and what kind of disk the library is
being stored on.

Is there a maximum library size?

No, there is no hard limit on the number of photos/videos you can add to a library. The library will
tend to get slower as it gets larger, but you’ll never hit a point where Photos will prevent you from
adding more items to the library.

Size vs. item count

When estimating how a library will slow down as it grows, the number of photos/videos in the library
is much more important than the size of the library in GB. For example, a 900 GB library made up of
3000 videos will be much faster than a 900 GB library made up of 150,000 photos.



Your disk

The speed of the disk that your library is stored on plays a major factor in Photos and PowerPhotos
performance when working with a photo library. Generally speaking, your internal SSD is going to be
the fastest, followed by external SSDs, then external “spinning platter” hard drives, and lastly
network drives such as a NAS or another Mac accessed via file sharing. You might consider a setup
where you keep your most recent and/or favorite photos in one library on your internal drive, and
then copy older photos to one or more libraries on larger, slower external/network drives.

Your Mac

The age of your Mac, the processor it has, and the amount of RAM is has, all play a part in how fast
everything on your system runs, including Photos. If your Mac is only a few years old, then
upgrading to a whole new system probably isn’t worth the price. However, if your Mac is older than
5 years or so, and you’re experiencing slowness in Photos and/or your system as a whole, then
getting a new machine might be worth it. This is generally viewed as a last resort.

Do a bit at a time

The best advice is to simply not worry about your setup too much ahead of time until you actually
start to experience slowdowns. If you’re looking to merge a bunch of libraries together, try merging
one library at a time, and then use Photos after each library gets merged in and see how it behaves.
If it seems OK, go ahead and merge the next library. If it seems to be getting slow, then maybe you
stop there and start a new library to hold all the rest of your photos instead.

9.11 How do I store my iCloud library on an external
drive?

One common issue using iCloud Photos on your Mac is when the amount of data you have in iCloud
Photos is too much for the internal drive on your Mac to hold all at once. Photo does include the
“Optimize Mac Storage” setting, which will tell Photos not to download the full size copy of a photo
until it’s specifically viewed in full size in the Photos app. This is convenient, but has a major
downside: because you no longer have local copies of all your photos, any local backups that are
made of your library will not contain all of your photos.

One solution for this problem is to move your iCloud library to an external drive that does have
enough free space to hold all your photos. That way, you know all your photos are locally available
and will be backed up by Time Machine or whatever other backup software you use on your Mac.

Creating the new library

If you already have iCloud Photos enabled on your Mac, here is how to move your library to an



external drive.

1. Open PowerPhoto and select your iCloud library. PowerPhotos will display an “iCloud Photos”
label below the library that is currently syncing with iCloud Photos. If you don’t see such a label
under any of your libraries, then you don’t have iCloud Photos enabled - refer to the “If you
don’t have iCloud Photos enabled” section below instead.

2. Choose File > Duplicate Library, then choose the folder on your external drive where you’d like
to store your library. You may also want to give it a distinctive name like “iCloud Photo Library”
or “External Library”. See Storing a library on an external drive for information on compatible
external drives.

If you don’t have iCloud Photos enabled, then instead of copying your existing library, you’ll create a
new library instead.

1. Open PowerPhotos and choose File > New Library from the menu bar.

2. Choose the folder on your external drive where you’d like to store the new library. You may want
to give it a distinctive name like “iCloud Photo Library” or “External Library”.

Switching iCloud Photos

Now that you have your library on the external drive, it’s time to switch iCloud Photos to sync with
that library.

1. Once you’ve copied/created your library, you should see the new library at the bottom of the
PowerPhotos library list. Double click on the library to open it in Photos.

2. Open the Settings window and go to the General section, then click on the button labelled “Use
as System Photo Library”. This will disable iCloud Photos on the library on your internal drive,
and switch your external library to be the new system photo library.

3. Finally, click on the “iCloud” section in the Settings window and check the “iCloud Photos”
checkbox to enable iCloud Photos on your external library. Assuming you want local copies of all
the photos, make sure to choose the “Download Originals” option instead of “Optimize Mac
Storage”.

4. The initial sync with iCloud Photos will likely take a while. It will start by comparing the content
of the local library with what’s in iCloud, then it will proceed to download any remaining images
that weren’t already downloaded. You can check its progress by selecting the main “Library”
album at the top of the album list in Photos, which shows all the photos in the library. Scroll all
the way to the bottom of the photo browser, and there should be a status message saying how
far along syncing with iCloud has proceeded.

Once you have your library setup, Photos will keep that copy of the library synced with iCloud
Photos going forward. It’s safe to disconnect the external drive and reconnect it later - Photos will
pick up syncing wherever it left off the last time the drive was connected. If you wish to switch back
to using your internal library with iCloud Photos, repeat the “Switching iCloud Photos” steps,
opening the internal library in Photos instead of the external library.



9.12 What is the 'Saved from PowerPhotos'
annotation?

When you use PowerPhotos to copy or merge photos between libraries, you may notice on iPhone or
iPad that it displays a “Saved from PowerPhotos” annotation in the info below the photo when
viewing them in the Photos app.

Understanding the annotation

The “Saved from PowerPhotos” annotation is not part of the normal keywords or tags assigned to
your photos. Instead, it’s a separate field maintained by Photos inside the photo library itself. Apple
primarily intends this feature to keep track of apps that add photos to the library, such as Instagram,
WhatsApp, or other third-party applications. This helps users identify where a photo came from if
they don’t remember adding it themselves.

Why PowerPhotos photos have this annotation

Because Apple automatically adds this annotation to any photo that’s added to a library by any third
party application, all photos that PowerPhotos copies from one library to another (e.g. during a
merge operation) will receive this annotation. This is standard behavior for all third-party apps that
interact with Photos libraries.

Impact on your photos

The good news is that this annotation:

Does not interfere with searching for keywords

Does not affect smart album filters

Is not included in the photo’s metadata when exporting

Does not appear in the actual image file

Only displays within the Photos app interface

Can it be removed?

Unfortunately, there is no way to remove this annotation once it has been added by Photos. Apple
does not provide any mechanism for third-party applications to prevent or remove these
annotations. However, since the annotation doesn’t affect the functionality of your photos or their
metadata, it’s primarily a visual indicator that can be safely ignored.



10. Troubleshooting

10.1 PowerPhotos crashing or hanging at startup
(safe mode)

If you are having an issue that is causing PowerPhotos to crash or hang at startup, you can try
enabling safe mode to see if that will let you at least get PowerPhotos open in order to troubleshoot
the problem.

To enable safe mode, hold down the shift key while PowerPhotos is opening up. You should see a
message saying that safe mode has been enabled.

When safe mode is enabled, the following things happen:

PowerPhotos will clear out any caches that it maintains, in case something in the cache has
been corrupted that is causing a problem

When selecting a library, instead of loading and displaying it automatically, you will instead see a
“Load Library” button that you can click to explicitly load the library

Since the vast majority of these types of crashes/hangs occur in the process of trying to display a
library, enabling safe mode will let you experiment and figure out which of your libraries is triggering
a hang or crash. You can then either remove that library, or select Help > Contact Support to get in
touch with us to figure out what’s going wrong with that particular library.

10.2 Reduced library size after merging

When using the Merge Libraries command in PowerPhotos, it can sometimes be the case that the
resulting library created by PowerPhotos is significantly smaller on disk that the original
library/libraries were. There are several reasons why the new library can be smaller than the original:

Recently deleted photos. When you delete items in your Photos library, they do not get
immediately removed from the hard drive. They instead get sent to the “Recently Deleted”
album in Photos, and are only deleted permanently after 30 days, giving you a chance to
recover them if you want. Until they either reach the 30 days or you delete them manually from
the Recently Deleted album, they will still take up space on the hard drive. Those recently
deleted photos are not included when merging libraries, so this can cause the merged library to
take up less space on disk than the original library.

Duplicate handling. If you have the duplicate handling option enabled when you set up the
merge, this will ensure that only one copy of each photo gets imported into the merged library.
If there are multiple copies of a photo in the original libraries, and the merged library only ends
up with one copy, that will result in the merged library being smaller than the originals.



Copying only original or edited version. When you edit a photo in Photos, it will keep an
unedited copy of the original photo, and create a separate JPG copy that contains the edits. If
you have set PowerPhotos to copy one of the two versions of the photo to the merged library
(e.g. in the settings window or when setting up a merge, then since the original library will have
two versions of the photo, but the merged library has only one, this can result in the merged
library being smaller than the original.

Database/cache fragmentation. Over time, the Photos database and cache files can acquire
some wasted space, from items that were deleted or changed, but for which the space was
never reused. The new library is likely to have less fragmentation, and thus have somewhat
smaller database and cache files. This is a relatively small effect compared to the other causes
outlined above, but it can still cause a difference in size.

10.3 Incomplete merge due to Photos crashes or
other errors

If you run a merge or a large photo copying session, and the merge ends prematurely due to either a
Photos crash, a PowerPhotos crash, or an error message that halts the merge, in most cases you
can simply set up a new merge and get the rest of the photos from your libraries copied that didn’t
make it the first time around. To do that:

1. Set up a new merge with the same source and destination libraries as you had the first time.

2. Enable the “Eliminate duplicates while merging” option. This will make sure that PowerPhotos
skips importing any photos that already got copied into the destination library the first time
around.

3. Enable the “Combine contents of albums with same name” option. This will ensure that
PowerPhotos reuses the set of albums it created in the destination library the first time around
rather than creating new ones.

If you have repeated problems trying to complete a merge or are unsure about the completion status
of your merge, contact us using the Help > Contact Support menu item within PowerPhotos. To
assist troubleshooting, make sure that all the boxes for including your PowerPhotos logs with your
support request are checked.

10.4 Find Duplicates seems to be missing some
duplicate photos

If you ran the Find Duplicates command and removed all the duplicate photos that PowerPhotos was
able to find, but are still seeing other photos in your library that appear to be duplicates, there are a
couple things you can try.



If you have some of the additional comparison options selected, which narrow down the possible
matches, try disabling all of them and let PowerPhotos do the widest search it can do.

If your duplicates are still not being found, then feel free to contact our technical support and send
an example of a pair of photos that look to be duplicates but aren’t being found by PowerPhotos.

The best way to send all the data and metadata for a photos it to select it in PowerPhotos then press
command-option-p. This will open up the “Contact Support” window with the photo selected to be
sent as an attachment. Just do that for each photo you want to send, then click “Submit” in the
support window to send the photos along for us to take a look at to troubleshoot the problem.

10.5 Allowing PowerPhotos access to your Photos
libraries

Recent versions of macOS have added a number of permission prompts displayed to the user when
apps access certain categories of data on your system. There are two such permissions that you will
need to grant to PowerPhotos in order to work with your photo libraries.

Photo library access

If a third party app such as PowerPhotos wants to work with your photo libraries, the first time it
attempts to do so you will be prompted to allow or deny PowerPhotos permission with a window that
looks like this:



This prompt will only be displayed once, so if you clicked “Don’t Allow”, then when you attempt to
view any of your libraries in PowerPhotos, you’ll receive an error message saying “Photos access not
authorized”. If you see such a message, you’ll need to go into System Settings and manually give
PowerPhotos permission to access your photo libraries.

“Data from other apps”

When running on macOS Sonoma and later, an additional prompt is put up when any third party app
tries to read data belonging to another app. In the case of PowerPhotos, it needs to read preference
settings from Photos in order to determine which library was last opened, which library is the
current system library, and whether iCloud Photos is enabled. This will trigger a prompt that looks
like this:



Unlike the photo library prompt, macOS insists on showing this prompt every time you launch
PowerPhotos. If you use PowerPhoto often and this gets annoying, you can optionally grant
PowerPhotos full disk access to prevent this prompt from coming up any more.

Changing photo library access permissions manually



macOS Monterey

1. Go to the Apple menu in the upper left corner of the screen and select “System Preferences”.

2. Click the “Security & Privacy” icon in the System Preferences window that appears.

3. Click the “Privacy” tab.

4. Scroll down the list on the left and click “Photos”.

5. Look for PowerPhotos in the app list and make sure the checkbox next to its name is checked.

6. Quit and reopen PowerPhotos for the changes to take effect.

macOS Ventura and later

1. Go to the Apple menu in the upper left corner of the screen and select “System Settings”.

2. Click the “Privacy & Security” icon in the list on the left.

3. Scroll down the list on the left and click “Photos”.

4. Look for PowerPhotos in the app list and make sure it says “Full Access” underneath. If it
doesn’t, use the toggle on the right to enable full access.

5. Quit and reopen PowerPhotos for the changes to take effect.

In some cases, the system interface for this can be outright buggy, and will not actually let you
toggle the setting successfully. In this case, you can instead reset PowerPhotos access permissions
from the terminal. To do that:

1. First, make sure to quit PowerPhotos if it is open

2. Open the Terminal application, which is located in the Utilities folder in your main Applications
folder

3. Copy and paste the following command into the terminal window, then press return to execute
it:

tccutil reset Photos com.fatcatsoftware.PowerPhotos

Open PowerPhotos again, and it should give you that prompt to access to your Photos library again
so you can click “Allow” there.

10.6 A merge, copy, or duplicate search stalls
without further progress

If you are performing a duplicate search, a merge, or another long photo copying operation and
PowerPhotos reaches a point where it no longer seems to be making progress, here are the
recommended troubleshooting options.

Make sure it’s actually stuck

First, take a minute to look at the progress being shown by PowerPhotos and see if the progress bar



or messages are changing at all. If things are still moving, even if very slowly, the best bet is to
simply let it proceed.

If it’s really stuck, cancel and try again

If the progress is indeed stuck and has been so for at least several minutes, then you can click the
“Cancel” button to cancel the current merge/copy/duplicate search. If you were doing a duplicate
search, start a new search with the same setup as before. If you were doing a merge, you can follow
the same instructions for restarting an incomplete merge as when a merge is interrupted by a crash.
If you’ve tried the same thing multiple times and it gets stuck in the same way every time though,
then it’s time to do something different.

If it gets stuck every time

The primary reason for PowerPhotos stalling in the middle of a large operation is if it has sent a
request or command to Photos and is waiting for a response, but Photos never returns a response to
PowerPhotos. The requests that PowerPhotos makes are handled by a background process called
“photolibraryd” which handles actually reading and writing data from the library database, even if
the Photos app itself isn’t running.

The best solution when this happens is to restart photolibraryd to get it out of whatever weird state
it’s in. There are a couple ways to do this, here’s the order I recommend them in.

1. Go to the Apple menu and choose “Log Out” to log out of your user account, then log back in
with your username and password.

2. Alternately, you can just restart your Mac

3. If you’ve got other things going on and really don’t want to log out of your user account entirely,
then you can open Activity Monitor, find the “photolibraryd” process in the process list, and
force quit it. You’ll want to quit both Photos and PowerPhotos before doing this. It’s still
recommended to log out if you can though, since that performs a clean shutdown of
photolibraryd rather than a force quit.

If you continue having trouble completing your merge/copy/duplicate search, then contact our tech
support and we can investigate your case further.

10.7 No location is shown for newly copied/merged
photos

In certain cases, right after you copy or merge photos from one library to another using
PowerPhotos, viewing those photos will show no information for the “Place” field in the inspector,
even though the original photos did have location information assigned tothem.

PowerPhotos does copy across the latitude/longitude info for each photo, but after importing,
Photos itself still performs the “reverse geocoding” which looks up the location of each photo and



assigns a place name to it, e.g. a neighborhood, city, state, etc. This lookup process happens in the
background and can take an unpredictable amount of time to complete. Until Photos finishes its
lookups, PowerPhotos will not have a place name to display when viewing the photo.

You should be able to confirm the latitude/longitude got copied over by viewing the photo in the
Photos app itself. You can control-click the photo in PowerPhotos and select “Reveal in Photos”,
which should open the library in Photos and show that photo. Pressing command-i will then bring up
Photos “Info” window, which will show the location at the bottom. If it’s still in the process of looking
it up, the info window will read “Looking up location info…”. Unfortunately there’s no way to force
Photos to perform the lookup immediately, you just have to wait around for a while until it decides to
finish processing in the background.



11. Settings

To access PowerPhotos’ settings, click on the “PowerPhotos” menu and select “Settings”. There you
will find the following settings:

General

Use small icons in library list: if you have a large number of libraries in your library list and
would like to be able to see more of them at a time, checking this box will reduce the size of
each row in the list, allowing more libraries to fit vertically in the list.

Warn when removing a library: by default, you will be given a warning message when
attempting to remove a library, confirming that you really want to remove it. You can uncheck
this option if you would not like this warning to appear.

Automatically check for updates: checking this box will make PowerPhotos check on the
internet for new versions at regular intervals. You can also check for updates manually using the
“Check For Updates” menu item.

Reopen library windows that were open at last quit: if you open one or more libraries in
separate windows, having this option checked will automatically reopen any library windows that
were open the last time PowerPhotos quit.

Photo Copying

Show preview before copying: when enabled, you will be shown a preview of what your library
will look like after the copy takes place, and which duplicate photos will be skipped.

Don’t copy duplicate photos: if this box is checked when you copy photos from one library to
another, any photos that are duplicates of ones already in the destination library will be skipped.
Otherwise, all photos will be imported, even if the destination library already contains copies of
them.

Duplicate comparison options: read more about these options in the “How to compare
photos” section of the Starting the duplicate finding process section of the manual.

Copy metadata: specifies which attributes on your photos you want to be preserved when
copying between libraries

Copy Live Photo videos: when enabled, both the photo and video components of Live Photos
will be preserved when copying or merging libraries, otherwise only the photo will be copied. If
you are not concerned with retaining the video portion of your Live Photos, disabling this can
speed up copying times (especially across a network) and help use less disk space.

Bursts: if you copy a burst mode photo between libraries, you can choose to have PowerPhotos
either copy all the photos from the burst, or just copy the key photo that is displayed for the
burst, leaving the rest of the burst photos behind.

Edits: determines what to copy when copying a photo/video that has been edited in Photos

Copy unedited original: only the unedited original version of each photo will be copied. Edits
that have been made to the photos will not be preserved copied to the destination librayr.

Copy edited version: if the photo has been edited, then the resulting JPG/HEIC copy of the



photo will be copied to the destination library, but the original verison of the photo will not be
included. This can be one way to save disk space if you don’t care about keeping the original
versions of photos that you’ve performed edits on. Originals will still be copied for photos and
videos that have not beed edited.

Copy both: this will copy both the original and edited version of each photo, while keeping
reversible photo edits intact. This settings preserves the most information and is the default.

Incomplete items: if some of the photo/videos being copied are incomplete, you can choose
whether you want PowerPhotos to import the parts of the item that are present, or just skip it
entirely.



12. Keyboard shortcuts

PowerPhotos tries to offer keyboard shortcuts in as many places as possible, to make it possible to
navigate within your photo libraries without having to reach for the mouse or trackpad if you don’t
want to. Here is a summary of available keyboard shortcuts.

Managing libraries

Action Shortcut

Create a new library Command-N

Add an existing library to the PowerPhotos library list Command-Shift-A

Remove a library from the PowerPhotos library list Command-Shift-Delete

Remove a library from PowerPhotos and move it to the trash Command-Shift-Option-Delete

Create a new library group Command-Control-N

Duplicate the selected library Command-D

Open the selected library in Photos Command-Shift-O

Open the selected library in a separate PowerPhotos window Command-Option-O

Reveal the selected library in the Finder Command-R

Managing albums/photos

Action Shortcut

Create a new album Command-Shift-N

Create a new folder Command-Option-N

Delete the selected albums or photos from the library Command-delete

Remove the selected photos from the selected album Delete

Toggle a photo’s favorite status Period (.)

Open Photos and reveal the selected photo in the Photos window Command-Shift-P

Album list



Action Shortcut

Move the selection up or down one row Up/down arrow

Select multiple albums going up or down Shift + up/down arrow

Expand the selected folder Right arrow

Expand the selected folder and all of its children recursively Option + right arrow

Collapse the selected folder Left arrow

Collapse the selected folder and all of its children recursively Option + left arrow

Add or remove a single album to the current selection Command + click

Add or remove a range of albums to the current selection Shift + click

Photo browser

Action Shortcut

Move the selection up/down/left/right Arrow keys

Scroll one page down Page down (fn + right arrow)

Scroll one page up Page up (fn + left arrow)

Scroll to the bottom of the photo browser End (fn + down arrow)

Scroll to the top of the photo browser Home (fn + up arrow)

Add or remove a single photo to the current selection Command-click

Add or remove a range of photos to the current selection Shift-click

View the selected photo full size Double click or space bar

Switch to grid view Command-1

Switch to list view Command-2

Single photo viewer



Action Shortcut

Advance to the next/previous photo Right/left arrows

Advance to the next/previous photo Two finger swipe right/left

Zoom in/out on the photo Pinch

Pan around a zoomed in photo Two finger drag/scroll wheel

Dismiss the photo viewer and return to
grid/list view

Double click, command + up arrow, space bar, or two
finger swipe down

Play/pause a video or animated GIF Option + space bar

Inspector

Action Shortcut

Move to the next metadata field (e.g. title, keywords, or caption). If the last field is
currently selected, advance to the next photo and move to the first field

Tab

Move to the previous metadata field. If the first field is currently selected, advance
to the previous photo and move to the last field.

Shift-tab

Advance to the next photo without changing the focused field
Option-
tab

Advance to the previous photo without changing the focused field
Option-
Shift-tab

Navigation



Action Shortcut

Move keyboard focus to the library list Control + 1

Move keyboard focus to the album list Control + 2

Move keyboard focus to the photo browser Control + 3

Move keyboard focus to the inspector Control + 4

Show Libraries Command-shift-l

Show Reports Command-shift-r

Show/hide the sidebar Command-control-s

Show/hide the inspector pane Command-i

Toggle full screen  + f or command-Control-f



13. Automation

PowerPhotos supports automating tasks with your photo libraries using two different technologies:
Shortcuts and AppleScript. Whether you want to set up a quick workflow to organize your photos, or
write a more complex script that manages your entire photo collection, PowerPhotos provides the
tools to do it.

Shortcuts lets you create visual workflows using PowerPhotos actions in the Shortcuts app. This is
the easiest way to get started with automation, and is great for creating simple, reusable workflows.

AppleScript provides a full scripting interface for PowerPhotos, giving you fine-grained control over
libraries, albums, and photos. AppleScript is well suited for more complex automation tasks, and can
be combined with other scriptable apps on your Mac.

13.1 Shortcuts

PowerPhotos provides a comprehensive set of actions for the Shortcuts app, letting you automate
common tasks with your photo libraries. You can use these actions to build workflows that browse
your libraries, organize albums, edit photo metadata, copy or move photos between libraries, export
photos to folders, and more. Shortcuts can be run on demand, or triggered by other events on your
Mac.

To get started, open the Shortcuts app and create a new shortcut. When adding actions, search for
“PowerPhotos” to see the full list of available actions. Each action has parameters you can configure
to customize its behavior. Many actions can also be chained together, with the output of one action
feeding into the next. For example, you could use the “Get Photos” action to retrieve photos from a
library, filter them using a built-in Shortcuts action, then pass the results to “Copy Photos” to copy
them to another library.

For more information about creating and using shortcuts on your Mac, see Apple’s Shortcuts User
Guide.

For downloadable example shortcuts demonstrating how to use these actions, see Example
Shortcuts.

Library actions

https://support.apple.com/guide/shortcuts-mac/intro-to-shortcuts-apdf22b0444c/mac
https://developer.apple.com/library/archive/documentation/AppleScript/Conceptual/AppleScriptLangGuide/introduction/ASLR_intro.html
https://support.apple.com/guide/shortcuts-mac/intro-to-shortcuts-apdf22b0444c/mac
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Action Description

Find Library
Searches for libraries matching a set of filters such as name, type,
and photo count.

Choose Library
Presents a picker to choose a library from the PowerPhotos library
list.

Get Libraries Returns all photo libraries in the PowerPhotos library list.

Get System Library
Returns the system photo library designated as the default by the
Photos app.

Add Library
Adds an existing photo library from disk to the PowerPhotos library
list.

Create New Library Creates a new, empty photo library at a specified location.

Duplicate Library
Duplicates a photo library to a specified folder and adds the copy to
the library list.

Open Library in
PowerPhotos

Opens a photo library in PowerPhotos.

Open Library in Photos Opens a photo library in the Photos app.

Remove Library Removes a photo library from the PowerPhotos library list.

Album actions
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Action Description

Find Albums
Searches for albums matching a set of filters such as name, type,
and photo count.

Get Albums
Returns albums from a photo library, with options to filter by album
type.

Create Album Creates a new album in a photo library.

Create Folder Creates a new folder in a photo library.

Rename Album Renames an album or folder in a photo library.

Delete Albums
Deletes albums from a photo library without deleting the photos they
contain.

Add Photos to Album Adds photos to an album within the same library.

Remove Photos from
Album

Removes photos from an album without deleting them from the
library.

Select Album in
PowerPhotos

Selects an album in the PowerPhotos window.

Photo actions

Action Description

Find Photos
Searches for photos matching a set of filters such as title, date,
keywords, and more.

Get Photos Returns photos and videos from a photo library.

Get Photo Metadata Gets metadata from one or more photos and returns it as text.

Set Photo Metadata Sets a metadata field to a new value on one or more photos.

Show Photo in Photos Opens the Photos app and reveals the specified photo.

Show Photo in
PowerPhotos

Shows a photo or video in the PowerPhotos photo viewer.

Delete Photos Deletes photos from their respective libraries.

Transfer and export actions
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Action Description

Copy Photos Copies or moves photos from one library to another.

Copy Albums Copies or moves albums and their photos from one library to another.

Import Photos Imports files and folders into a photo library.

Export Photos Exports photos, albums, or a library to a folder using a saved export preset.

Merge Libraries Merges one or more source libraries into a destination library.

13.2 AppleScript

PowerPhotos provides a full AppleScript dictionary that lets you script nearly every aspect of
managing your photo libraries. You can use AppleScript to browse libraries and albums, read and
modify photo metadata, copy and move photos between libraries, export photos, merge libraries,
and more.

To explore PowerPhotos’s AppleScript dictionary, open Script Editor (located in
/Applications/Utilities/), then choose File > Open Dictionary and select PowerPhotos from the list.
This will show you all of the available classes, commands, and properties that you can use in your
scripts. You can also write and run scripts directly in Script Editor to test them out.

For more information about writing AppleScripts, see Apple’s AppleScript Language Guide and the
Mac Automation Scripting Guide.

Data model objects

These are the main objects you work with when scripting PowerPhotos.

Object Description

application The top-level scripting object representing the PowerPhotos app.

window An open window in PowerPhotos.

library A Photos library in PowerPhotos.

library group A group of libraries in the library list.

album An album, smart album, or folder in a library.

photo A photo or video in a library.

export preset A saved export preset that defines export settings.
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Standard Suite commands

These are standard commands that PowerPhotos supports.

Command Description

count Return the number of elements of a particular class within an object.

delete Delete an object such as a library, album, or photo.

exists Verify that an object exists.

make Create a new object such as a library, album, or folder.

move Move photos or albums to a different library.

PowerPhotos Suite commands

These are commands specific to PowerPhotos.

Command Description

add Add photos to an album.

remove Remove photos from an album.

merge Merge multiple libraries into one.

duplicate Copy albums or photos to another library.

import Import files and folders into a library.

export Export photos or albums to a folder on disk.

Enumerations

PowerPhotos defines several enumerations used as parameter values in commands and properties.
See the enumerations reference for a complete list.
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14. Support

If you are experiencing a problem using PowerPhotos, you can contact tech support in two ways.

Open up PowerPhotos and select “Contact Support” from the Help menu. This will bring up a
window where you can explain your problem and send it directly to Fat Cat Software support. This is
the preferred method, as it will automatically transmit basic information about your setup that will
help in making sure your problem can be diagnosed quickly and correctly. The following information
will automatically be included with your request:

The version of PowerPhotos you have installed

The version of Photos you have installed

The version of macOS you have installed

Your PowerPhotos settings file

Your Photos settings file

Checking the “Include logs & reports” checkbox will send the reports and log files created by
PowerPhotos while performing various operations.

Additionally, if you are experiencing a problem that involves Photos crashing or PowerPhotos
crashing, you can include the appropriate crash log(s) with your submission. All information that is
submitted is transferred over an encrypted SSL connection.

Alternately, you can also e-mail for support at {% include support_link.html %}



15. Glossary

Active Library The active library (referred to as “last opened” in some places) is the library that
was most recently opened in the Photos app. In PowerPhotos, the active library is designated with a
green checkmark next to it in the library list. If you open Photos directly via the Finder or Dock, the
active library is the one you will see displayed there. You can change the active library either by
clicking the checkmark next to it in the library list, or by double clicking the library in PowerPhotos
or the Finder to open it in Photos.

Album To further organize your photos, you can create any number of albums in a Photos library,
and add any number of photos to each album. Adding a photo to an album does not create a copy of
the photo, so multiple albums can reference the same photo without taking up more disk space.
Removing a photo from an album only removes it from that album, so that photo will remain in the
library, as well as any other albums it belongs to. Similarly, deleting an album does not delete the
photos it contains from the library.

Consolidate If you have imported some photos into your library as referenced photos, Photos
provides a “Consolidate“ command in its File menu which will copy those photos from the folder
they're located it into the library itself, converting them from referenced to managed photos. You
may want to consolidate referenced photos if you plan on copying the library to another hard drive,
since doing so will often break any references to external folders.

Convert If you have an old iPhoto or Aperture library that is no longer supported by your Mac, you
can use PowerPhotos to convert the library to a Photos library. This replaces the migration feature
that used to be available in older versions of the Photos app.

Duplicate Photo The term “duplicate photo“ is actually surprisingly hard to define, since different
people have different concepts on whether they consider two photos to be duplicates. Photos that
are 100% identical byte for byte are obviously duplicates, but many people also don't want to have
multiple copies of what is essentially the same photo even if they're different in some ways, such as
one being in a different format, a different size, or having different metadata.

PowerPhotos uses a visual duplicate detection engine that tries to match up photos that derive from
the same original photo. It also provides additional comparison options to further narrow down its
matches for people who want more precision in what they consider identical, e.g. requiring the
photos' filenames or dates to match.

When PowerPhotos completes its search, it refers to all the photos it has found as “duplicates”
which are displayed in a number of “duplicate groups”. Each duplicate group will have one photo
marked as a “keeper”, with the rest of them marked to be “trashed“.

Event Events were a feature that was implemented by iPhoto, but no longer exists in the newer
Photos app. Whenever you imported a batch of photos, they would be put into one or more events,
which were an alternate way to organize photos in addition to albums. When you migrate a library
from iPhoto to Photos, Photos will convert the events from the iPhoto library into equivalent albums,
and store those albums inside a folder named “iPhoto Events” in your library. No new albums get
added to this folder as you import new photos using the Photos app though. If you never used
events or don't need them any more, you can safely delete the “iPhoto Events” folder from your
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library.

Export Exporting refers to copying photos from a Photos library to a plain folder outside of Photos.
Photos has a built-in export command, but PowerPhotos provide one of its own that offers several
additional options above what Photos offers.

Folder A folder, in the context of Photos, refers to a folder created in the album list of your library
that you can use to organize your albums into a hierarchy. This is the same concept as a folder in the
Finder, but used to group albums instead of files, and it only appears when viewing your Photos
library.

iCloud Photos iCloud Photos is a service provide by Apple that will sync your Photos library across
multiple devices, including Macs, iPhones, and iPads. On your Mac, only your system library can
sync with iCloud Photos.

iCloud Shared Library iCloud Shared Library is a feature Apple introduced in macOS Ventura which
lets you share part or all of your library with other people using iCloud Photos. Read here for more
information on how PowerPhotos interacts with iCloud Shared Library.

Import Importing refers to adding new photos to a library from outside Photos, either by dragging
them in from the Finder, or plugging in an iPhone or other digital camera. You can also import
directly into a particular library by dragging photos into a library in PowerPhotos. Importing this way,
PowerPhotos can also weed out duplicates in the process.

Incomplete item Some photos or videos in your library can have multiple pieces of data behind the
scenes, e.g. an edited copy of a photo or a video associated with a Live Photo. If one of these pieces
of data is not present on disk, PowerPhotos calls that an **incomplete item** and performs special
handling for it. Read here for more information on how PowerPhotos handles incomplete items.

Keeper After finishing a duplicate search, PowerPhotos displays all the duplicates it has found in a
number of duplicate groups. Each group of duplicates has one photo marked as the “keeper”, with
the rest marked as to be “trashed”. You can use duplicate rules and manual changes to adjust which
photos you want to be marked as the keepers.

Hidden Photos supports “hiding“ photos, by using the Image > Hide Photo menu item in the Photos
app. Hidden photos are not displayed when browsing through your library, in either Photos or
PowerPhotos, nor are they shown in albums. You can view your hidden photos by selecting View >
Show Hidden Photo Album in the Photos app, then selecting the “Hidden” album in the album list.
You can then unhide photos by selecting them and using the Image > Unhide Photo menu item.
PowerPhotos cannot see or work with hidden photos, so any such photos will not be included when
copying albums or merging libraries. If you want them included in your copying operations, you must
first unhide them using the Photos app.

Library A Photos library contains a collection of photos and their associated metadata, along with
any albums and projects that you've created that use those photos. By default you only have a
single library, which PowerPhotos calls the “Default Library”, and that is the library you see when you
open the Photos app. PowerPhotos lets you create multiple libraries and switch between them in the
Photos app.

A library is a self-contained unit, so making changes in one library does not affect any other
libraries. Each library can be seen as a single item in the Finder, and all the photos and other data for
the library are stored inside there, so you can easily copy a library from one place to another either

https://support.apple.com/en-us/HT204264
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using the Finder, or the “Duplicate Library” menu item in PowerPhotos.

Library Group Library groups are a feature provide by PowerPhotos to help further organize your
libraries in the PowerPhotos library list. Library groups only appear in PowerPhotos, and moving
libraries between groups in PowerPhotos has no effect on where they reside on disk.

Merging Merging libraries is a feature provide by PowerPhotos that lets you combine the contents
of multiple libraries into one. During a merge, the contents of one or more existing libraries will be
copied into another library, including all photos and albums, with duplicate photos being skipped.
Not to be confused with Migrating.

Migrating Migrating is the process of taking an old iPhoto or Aperture library and converting it into
an equivalent Photos library containing the same photos and albums as the library. As of macOS
13.0 “Ventura” and later, Photos no longer supports migrating iPhoto libraries, but you can instead
use PowerPhotos to convert your iPhoto/Aperture libraries to Photos.

Missing item If a photo or video listed in your library is not present on disk, then PowerPhotos calls
that a **missing item** and performs special handling for it.. Read here for more information on how
PowerPhotos handles missing items.

Optimize Storage When you have iCloud Photos enabled, you can choose the “Optimize Storage”
option in the Photos settings window. With this setting enabled, Photos will not download the full
size original photos to your local hard drive right away. You can still browse through your entire
library, and Photos will automatically download photos on demand as needed when you view or edit
them. This option only applies to your system library, and only when iCloud Photos is enabled.

PowerPhotos can work fully with the Optimize Storage option, and will also download photos as
necessary when viewing or copying them. Special care is needed, however, when making a copy or
backup of the entire library. Read more about this in the “Backing up your Photos Libraries” section
of the PowerPhotos manual.

Partial copy If PowerPhotos encounters incomplete items when performing a copy or merge, you
can choose to have PowerPhotos copy whatever data is available even if some is missing. Read here
for more information on how PowerPhotos performs partial copies.

Original When you import a photo into your Photos library, that photo is called the “original” and is
never modified after being imported into the library. When you edit a photo in your library, Photos
create a separate copy of the photo and applies the edits to that copy of the photo. You can later
use the “Revert to Original” menu item to discard the edits and display the original photo again.

It's important to note that PowerPhotos does not use the term “original” when talking about
duplicate photos, because there is no solid way to define which of a group of duplicates might be
considered the “original”. Instead, PowerPhotos chooses a “keeper” and the rest of the duplicates
are marked to be trashed.

Referenced Photo Normally when you import photos into your library, Photos makes its own copies
of those photos and stores them internally in the library package. In the Photos settings window,
there is an option labelled ”Copy items into Photos library” which is on by default. If you uncheck
that checkbox, then rather than making its own copies of imported photos, Photos will instead just
reference the original photo in whatever folder it was in at the time you imported it. Photos that are
not imported as references are typically called “managed” photos.

file:///Users/bwebster/Projects/UberProject/PowerPhotos/Docs/chapters/migrate_libraries.html
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Referenced photos have the advantage that you can keep your photos organized in an external
folder and organize them using Photos as well, but without having to keep two separate copies of
the photo on disk. The disadvantage is that if you delete or move the photos from the folder they're
located in, then Photos may lose track of them and no longer be able to edit, export, or share copies
of those photos.

Shared Albums Shared Albums (not to be confused with iCloud Shared Library) allow you to create
custom albums and add photos to them to share them with other people. Shared albums are stored
separately from your Photos library, unlike regular albums and folders that are part of the library
itself. Shared albums do not count against your normal iCloud storage, but there are limits to how
many photos you can put in a shared album, the copies of the photos in the album get scaled down
from the original size, and shared album photos cannot be edited like photos in your library. Read
more on Apple's website about how to work with shared albums.

System Library You can have multiple Photos libraries set up on your Mac, but at any given time
only one of them can be designated the “System Library”. The system library will be the one that
appears in most other applications, e.g. when they provide a photo picker to insert photos from your
library. The system library is also the only library that can have iCloud Photos enabled. You can
switch the system library via the Settings window in the Photos app.

https://support.apple.com/en-us/HT202786


16. Release Notes

{% assign releaseNotes = site.powerphotos_releasenotes | sort: “bundle_version” | reverse %} {%
for note in releaseNotes %} Version {{ note.version }} (released {{ note.release_date }})

{{ note.content }}

{% endfor %} iPhoto Library Manager release notes
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